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Preface 
Overview of the FreeStyle CoPilot Health Management System

The FreeStyle CoPilot Health Management System is a versatile tool that allows people with 
diabetes, their caregivers, and healthcare professionals to take a more informed role in managing 
diabetes by acting as a data management tool. The FreeStyle CoPilot system tracks diabetes-
related health information, and provides graphs, charts and reports that can help both patients 
and healthcare professionals evaluate needs and options for a diabetes health management 
program.
The FreeStyle CoPilot Health Management System (“the FreeStyle CoPilot system”) allows you to 
upload recorded test results from supported Abbott Diabetes Care blood glucose monitoring 
systems. The FreeStyle CoPilot system also allows you to record information about insulin, ketones, 
medications, meals, exercise, state of health, medical exams, lab results, as well as general notes.
The FreeStyle CoPilot system displays trends and patterns in glucose readings, carbohydrate 
intake, insulin dosage, and other diabetes-related factors. 
The FreeStyle CoPilot system can be installed in one of two modes or, versions. The Home User 
version is for people with diabetes, or their caregivers. The HCP version is for healthcare 
professionals (HCPs). When you install and use the FreeStyle CoPilot system for the first time, you 
must specify which version you use. Both versions provide the same tools to record, track, view 
and analyze individualized health information. When needed, this guide provides instructions 
specifically for each version and type of user. 
To allow multiple home users (such as a family) and multiple HCPs (such as in a clinic) to share the 
use of the FreeStyle CoPilot system, each user has a Profile. The information for each profile can 
be made secure with a unique password. 
In addition, home users and HCPs can use the FreeStyle CoPilot system to share data and recorded 
health information by synchronizing (via the Internet) with the FreeStyle CoPilot system Host. 
Synchronization is the term used to refer to the exchange of information via the FreeStyle 
CoPilot Host.

Intended Use and Application

The FreeStyle CoPilot Health Management System is intended for use in home and clinical 
settings by patients and healthcare professionals. It is intended to aid people with diabetes and 
healthcare professionals in the review, analysis, and evaluation of information such as historical 
blood glucose test results, insulin dosages, carbohydrate intake, and exercise data in support of 
an effective diabetes health management program. It can be used with supported Abbott 
Diabetes Care blood glucose monitoring systems (as listed in Appendix C: Supported Devices and 
Databases), where data is uploaded, saved, analyzed, displayed as charts, graphs and reports, 
printed, and shared with an authorized party.
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Purpose and Scope

This User’s Guide provides computer requirements, installation steps, and configuration 
options. It provides instructions and procedures for setting up user profiles, for uploading, 
recording and importing data, for viewing reports, and for sharing information between 
healthcare professionals and diabetes patients via the FreeStyle CoPilot system Host. This guide 
also provides instruction for managing system security and data integrity by using logon 
profiles and passwords, and for managing user rights. Finally, information is provided for 
troubleshooting and obtaining technical support.

Software Availability

You can obtain the software by calling Customer Care at 1-888-522-5226 in the USA.

Computer Requirements

The following are minimum requirements for the FreeStyle CoPilot system operation. 

•	 Microsoft Windows XP (32-bit), Windows Vista (32-bit or 64-bit), or Windows 7 (32-bit or 
64-bit)

	 (The FreeStyle CoPilot system does not run on Apple computers.)
•	 RS-232 Serial port, or USB port 

The following components are needed or recommended for optimal use of the FreeStyle 
CoPilot system features: Internet connection, email account, 1024 x 768 resolution monitor,  
CD-ROM drive, color printer, fax software.

Technical Support and Customer Care

Please contact Abbott Diabetes Care, Customer Care if you need assistance. 

•	 The toll-free phone number is 1-888-522-5226 in the USA. 
•	 Customer Care is available Monday through Friday, 8AM to 8PM Eastern Standard Time.
•	 FreeStyle CoPilot system Support Specialists are available Monday through Friday from 

9:00 a.m. to 5:00 p.m., coast to coast. 
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1   Introduction
The FreeStyle CoPilot Health Management System (“the FreeStyle CoPilot system”) allows 
people with diabetes, their caregivers, and healthcare professionals to take a more informed role 
in managing diabetes by acting as a data management tool. The FreeStyle CoPilot system tracks 
health information and provides graphs, charts and reports that can help people with diabetes 
and healthcare professionals evaluate needs and options for a diabetes health management 
program. 

This section introduces and explains the FreeStyle CoPilot system features, installation options, 
user roles and activities, terminology, day-to-day procedures, and on-screen navigation for both 
home users and healthcare professionals. 

All users should read this section to understand key features and capabilities and different ways 
that you can use the FreeStyle CoPilot system. 

1.1      Modes of Operation

The FreeStyle CoPilot system can be installed in one of two modes, or versions. The Home User 
version is for people with diabetes, or their caregivers. The HCP version is for healthcare 
professionals. When you install and use the FreeStyle CoPilot system for the first time, you must 
specify which version you use.

Both versions appear and operate in very similar ways. Both provide the same tools to record, 
track, view and analyze individualized healthcare information. Each version displays slightly 
different menus, screens and configuration options to accommodate both the home user and 
HCP. This guide provides instructions as needed for each version and type of user. 

1.2      Overview of Home User Activities

The FreeStyle CoPilot system allows you to upload, record, store, analyze and share important 
information about your glucose readings, insulin, exercise, medication and other health 
information. 

The following is an overview of typical, routine use of the FreeStyle CoPilot system for home 
users:

•     �Install the FreeStyle CoPilot system and set up your profile using easy-to-follow forms, to 
specify personal and health information, your glucose targets, and much more.

•     Set up user preferences so that the system works best for you.
•     Upload test results from your blood glucose meter to the FreeStyle CoPilot system.
•     �Record your carbohydrate intake, insulin, exercise, state of health, medical exams, 

medications, ketones, lab results, and general notes. Keep as much or as little information 
as you and your HCP find helpful.

•     �View and print many types of graphs, charts and reports that will help you understand and 
track the progress of your diabetes health management plan.

•     Share your health information securely with your HCP, using the FreeStyle CoPilot Host 
system.
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1.3      Overview of HCP User Activities

As a healthcare professional, you can use the FreeStyle CoPilot system to observe trends and 
patterns in your patients’ glucose readings, and to review exercise, medication and other health 
information important to effective diabetes management.

The following is an overview of typical, routine use of the FreeStyle CoPilot system for 
healthcare professionals:

•     Install the FreeStyle CoPilot system and set up your HCP profile using easy-to-follow 
forms.

•     Set up user preferences and system options.
•     Create a FreeStyle CoPilot system Host account, and give your account number to 

patients.
•     Set up a patient profile for each patient with a supported device.
•     Receive health information from patients using the FreeStyle CoPilot system Host.
•     View and print charts, graphs and reports.
•     View a Group Analysis Report for a summary of all patient data.
•     Configure multiple HCP profiles and groups of patients.
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1.4      FreeStyle CoPilot System Terminology 

The following terms are used in the FreeStyle CoPilot Health Management System and this 
User’s Guide:

Healthcare Professional - A healthcare professional (HCP) is a physician, nurse practitioner, 
certified diabetes educator (CDE), or other healthcare professional authorized to provide care 
to patients with diabetes; a healthcare group or entity such as a clinic; or case manager. 

Home User - A home user is a person with diabetes, or their caregiver. (In the HCP version, a 
home user is called a “patient.”)

Profile - Each home user and HCP creates a profile. The home user profile is a collection of 
personal information, and the FreeStyle CoPilot system preferences, permissions and options. 
The HCP profile is a collection of professional identification, health management preferences, 
and the FreeStyle CoPilot system options. 

Data - Information recorded by any supported medical device and uploaded to the FreeStyle 
CoPilot system. See Appendix C for a list of supported devices, and the data collected and 
uploaded.

Health Information - Personal and medical information recorded by (or for) a patient. 
Information categories include: Glucose Readings, Insulin Doses, Meals, Exercise, State of 
Health, Medications, Medical Exams, Lab Results, Ketone Readings, and General Notes.

Reports - Reports are charts, graphs, and tables generated by the FreeStyle CoPilot system. 
There are at least 13 types of reports. You can use powerful filters to select the types of data, 
date ranges, etc., that you would like to view. You can also save, print, email and Fax (with 
installed Fax software) any report that you generate.

Database - All the FreeStyle CoPilot information is stored in a database file. Database 
information can be archived, exported and imported. Database files can be backed-up, copied 
and stored to ensure data integrity and safekeeping. 

FreeStyle CoPilot Host - The FreeStyle CoPilot Host is an Internet-based synchronization 
service provided by Abbott Diabetes Care. It allows home users to invite an HCP (or other 
designated party such as a parent) to securely share uploaded data and manually recorded 
health information. 

Synchronize - Home users and HCPs use the FreeStyle CoPilot Host to “synchronize” - or, update 
and exchange - profiles, data, and health information (“information”). Synchronize means to 
send more recent information to and/or receive more recent information from the FreeStyle 
CoPilot Host.



Back to Table of Contents 	 4

Section 1: Introduction

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

1.5      Warning, Caution and Important Messages in this Guide

Warning, Caution, and Important messages are included throughout this User’s Guide. These 
messages warn you to pay careful attention to specific instructions and guidelines for using the 
FreeStyle CoPilot system. 

Before using the FreeStyle CoPilot system, read each message included in the FreeStyle CoPilot 
system User’s Guide (See Appendix D: Warning, Caution and Important Messages, for a list of all 
messages). Always seek the advice of a healthcare professional before making any change in 
your lifestyle or use of medication.

Warning, Caution, and Important messages have a very specific meaning. The following list 
explains the meaning and purpose of each: 

WARNING:
•	 WARNING indicates possible hazards that, if not avoided, could result in serious 

injury or death. 

CAUTION: CAUTION indicates possible hazards that can cause harm to yourself, or to your 
patients.

IMPORTANT: IMPORTANT indicates that inconvenience to you (such as loss of text entries or 
saved settings) may result if you do not follow instructions.
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1.6      Getting Around - The FreeStyle CoPilot System Home Page

The FreeStyle CoPilot system uses menus, buttons, icons, tabs, drop-down lists, “mouse-button 
clicks”, check boxes, text fields (that you can type in), and other common Windows screen 
elements for operation and navigation. This guide assumes that all FreeStyle CoPilot system 
users have a clear understanding of how to use these software controls.

1.6.1   The FreeStyle CoPilot System Home Page

In this User’s Guide, certain terms are used to describe how (or, where to click) to perform 
procedures -- such as icon, button, menu and user list. These are explained below.

Tip: To return to the Home page from any other screen, click the “Home” icon.

Figure 1.  The FreeStyle CoPilot System Home Page (Home User)
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1.6.2   Menu Bar

The menu bar provides commands for the FreeStyle CoPilot system features and operations 
(including the features that you can use by clicking buttons and icons.)  

The following are two examples of how instructions are written for using commands on the 
menu bar.   

•     Click File > Database Maintenance > Archive to export data to an archive file.
•     Click Reports on the main menu, and select Diary List.

Also, an instruction may direct you to use an icon or button. 

•     Click the Read Device button to upload data from your device. 

1.6.3   Shortcut Keys

Menu commands, buttons and icons often provide a keyboard shortcut.

Many menu items have shortcut keys, such as Ctrl+P to print.
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Many icons have a “popup” (which appears when you hold the mouse pointer over the icon) 
that indicates the shortcut key, such as Ctrl+6 to enter a medication event.

1.6.4   Select User, Select HCP, and Select Patient Lists

You can search for a User/Patient by entering the first few characters of the Last name, First 
name, or ID in the search field, and clicking the Start Search button or pressing Enter.  Clicking 
the Start Search button without any search criteria will display all Users/Patients.  Click the 
Clear Search button to clear the current search.

For Home Users

The Select User list is displayed in the Home page in the home user version. The list includes 
the system administrator, and at least one home user profile.

Note:	   �If you have more than one home user profile on your system, verify that you select the 
correct home user before you upload data, record health information, or change 
profile settings. 

For HCPs

The Select HCP and Select Patient lists are displayed on the Home page in the HCP version. 

Note:	� Verify that you select the correct patient before you upload data, record health 
information, or change profile settings.
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1.6.5   Small Icons

Small icons are displayed on the Home page under the menu bar. In this User’s Guide, these are 
referred to as Icons. For example: Click the Home Icon to return to the Home page.

In addition to icons on the Home page, several other screens display icons. You can use these 
icons as described in procedures. 

Home User Icons

Home User Tip: Select UserProfile > User Profile > Options > Show Button Captions to see 
button captions.

HCP Icons

HCP Tip: Select UserProfile > HCP Profile > Options > Show Button Captions to see button 
captions.

Icons and Associated Actions

•     Home - Return to the FreeStyle CoPilot system home page.
•     Read Device - Upload data from a blood glucose meter or other device.
•     Quick Print - Upload data and automatically print selected Favorite Reports without 

saving the data to a user (or patient) profile.
•     Manual Entry - Record health information events; open the Data Entry screen.
•     View Reports - Open the Report screen to the default report you select in Options.
•     �Synchronize/Synchronize Current HCP - Upload / download (exchange) the most 

recent profile and health information with the FreeStyle CoPilot Host system.
•     �User Profile/Patient Profile - Open the home user (or patient) profile to view or to edit 

information.
•     Help - Open this User’s Guide to the appropriate section for help.
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1.6.6   Large Buttons

Large Buttons on the Home page provide shortcuts to commonly used actions.

Home User Buttons

HCP Buttons

Buttons and Associated Actions

•     �User List (Home User) - Open the User List to add, edit or delete home users from the 
home user list.

•     Patient List (HCP) - Open the Patient List to add, edit or delete patients.
•     Read Device - Upload data from a blood glucose meter or other device.
•     Quick Print - Upload data and automatically print selected Favorite Reports without 

saving the data to a user (or patient) profile.
•     Manual Entry - Record health information events; open the Data Entry screen.
•     View Report - Open the Report screen to the default report you select in Options.
•     �User Profile (Home User) - Open the profile of the home user selected in the Select User 

list to view or edit information.
•     �Patient Profile (HCP) - Open the profile of the patient selected in the Select Patient list 

to view or edit information.

1.6.7   Resource Links

If you installed extensions or plug-ins for other devices, additional options appear under 
Resource Links. Refer to the documentation provided with your device for more information 
about using these links. 
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1.6.8   Messages From FreeStyle CoPilot Host

If you use the FreeStyle CoPilot Host, messages appear in this window when you synchronize. 
Messages include information about data sharing, healthcare management and updates to the 
FreeStyle CoPilot system. See Section 7: Sharing Data with the FreeStyle CoPilot Host for more 
information. 

1.6.9   FreeStyle CoPilot System Help 

Use the help feature in the FreeStyle CoPilot system from virtually any screen or window. There 
are two options:

•     Click Help > Contents on the menu bar to open the help feature.

•     The context-sensitive help option is available in many screens and dialog boxes. Click 
Help or the question mark icon, to open the help feature at the appropriate section.

1.6.10   Pictures of the FreeStyle CoPilot System Screens

•     �In this guide, pictures of the FreeStyle CoPilot system screens may be from either the 
home version or HCP version. If the information or procedure is specific to a particular 
version of the FreeStyle CoPilot system, the image used is from the relevant version.

•     The figures within this guide are intended to serve only as examples.
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2   FreeStyle CoPilot System Installation
This section provides detailed installation instructions for the FreeStyle CoPilot Health Management 
System. 

2.1      FreeStyle CoPilot System Installation Overview

Select an Application Mode
When you install the FreeStyle CoPilot  system and start the application for the first time, the 
FreeStyle CoPilot system asks you to specify if you are a home user, or healthcare professional. 
When you make your selection, the FreeStyle CoPilot system completes the final installation 
step and enables the version appropriate for you. 

Both versions operate and look almost identical. Home users and HCPs use the same features 
and follow many of the same procedures. However, there are differences, and these require 
separate instructions in this User’s Guide. Separate instructions are clearly identified for the 
home user or HCP. Where applicable, be sure to read the correct instructions.

Note:	   It is very important to select the right option.

FreeStyle CoPilot System Network Installation
To allow multiple users to work from more than one computer, and to share one database, you 
can perform the FreeStyle CoPilot system network installation. This is recommended only for 
HCPs who work in a clinical setting with other HCPs. See Appendix E: FreeStyle CoPilot System 
Network Installation, for more information.

Upgrading from a Previous Version of the FreeStyle CoPilot System
If you are installing an upgrade to a previous version of the FreeStyle CoPilot system, your data 
is automatically migrated when installing the new version.  You will also be prompted during 
the upgrade to allow the installer to automatically uninstall the previous version prior to 
installing the upgrade.

2.2      Standard Installation Procedure

When you start the FreeStyle CoPilot system for the first time, the application asks you to 
specify if you are a home user, or healthcare professional. This step is a part of the installation 
procedure. 

Before You Install the FreeStyle CoPilot system
•	 Verify computer requirements as listed in the Preface.
•	 Save all information and close all running applications.

Note:	 Please have your glucose meter or other supported device available during installation.
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2.2.1   Install the FreeStyle CoPilot system

These steps correspond to the FreeStyle CoPilot system installer screens, which provide 
additional instructions. Screen names are in Italic.

1.	 Start the installer.
•     Insert the CD-ROM into the drive. (Most computers start installation automatically.)
                  —OR—

•     Double-click the FreeStyle CoPilot system installer file (CoPilot_Setup.exe).
2.	 Installation Language - Select the Installation Language, and click OK.
3.	 Welcome Page - Read the welcome page and click Next to continue or Cancel to quit.
4.	 License Agreement - The End User Agreement is displayed. Read it, select I Agree and then 

click Next to continue or click Cancel to stop the installation.
5.	 Confirmation - Click I Confirm to continue. Click I Do Not Confirm to return to the license 

agreement.
6.	 Installation Destination - Verify the installation folder. We recommend that you keep the 

preselected folder. (If required, click Browse to select another folder.) Click Next.
7.	 Start Installation - The installer is ready to begin. Click Next to proceed. Alternatively, click 

Back to make changes in previous screens or click Cancel to stop the installation.
8.	 Installation Progress - A screen shows installation progress.
9.	 Success Message - Installation is complete. You may need to install additional software if you 

use certain devices. Click Finish. 

10.	 The FreeStyle CoPilot system icon  is placed on your desktop, and in your Start Menu.
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2.2.2   Select Application Mode

To complete installation, you must launch the FreeStyle CoPilot system and choose the Application 
Mode.
1.	 Double-click the FreeStyle CoPilot system icon on the desktop to launch the FreeStyle 

CoPilot system.
2.	 Initial User Setup - Select the Application Mode, either:

•     Home User 
•     Health Care Professional

Note:	 You cannot change your selection after you click OK. If you select the wrong option, you 
will need to reinstall the FreeStyle CoPilot system. Contact Customer Care for assistance.

3.	 Enter your Name, a User ID and Password then Click OK. 

Figure 2.  Initial User Setup

4.	 Continue the FreeStyle CoPilot system setup procedures. Go to Section 3: HCP and Home 
User Profiles.
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3   HCP and Home User Profiles
If you are a home user, read Section 3.1, Home User - Profile Setup.  
If you are an HCP, read Section 3.3: HCP - Setting Up Your User Profile

3.1      Home User - Profile Setup

This section explains how to create and use profiles. It describes the five parts of the home user 
profile (called Tabs): User Information, Health Profile, Data Entry Preferences, Glucose 
Targets, and Options. Each tab is a form that you fill out using open text fields, drop-down lists, 
and check boxes. 

This section describes how to:

•     Choose settings, preferences and options to customize reports, data entry, printing, and 
much more.

•     Set up and manage other home user profiles.
•     Create and manage HCP profiles in the HCP list.

3.1.1   What is a Home User Profile?

Every home user can set up a home user profile. A profile contains personal information and a 
brief medical history. A profile also allows you to select options and preferences that you can 
use to specify glucose targets, daily time periods (meals, sleep, etc.), how reports are displayed, 
and items that you want to see listed when you record important health information - such as 
your medications, exercise, and insulin doses. 

Use your profile to specify:

•     �Your contact information, age, health, weight, type of diabetes, year of diagnosis, other 
medical conditions, etc. 

•     �Your glucose targets and daily time periods (meals, sleep, etc.) - which change how some 
charts, graphs and reports are displayed.

•     �Categories you would like to use when entering health information events, such as 
ketones, exercise, lab results, and exams.

•     �Items in health information events that you want to see listed when you record patient 
health information - such as medications, exercise, and insulin doses. 

•     �Whether to automatically print your favorite report(s) when you upload glucose meter 
or other device readings.

•     The default date-range you would like to see in your reports such as 7 days, one month, or 
three months.



Back to Table of Contents 	 15

Section 3: HCP and Home User Profiles

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

Note:	 Preferences and settings in your profile affect your use of the manual entry and reports 
features in the FreeStyle CoPilot system. For more information that will help you 
complete your profile, read  Section 4: Entering Data into the FreeStyle CoPilot System, and 
Section 5: Viewing and Printing Reports.

1.	   Click the User Profile button  (or, click UserProfile > User Profile.)

Figure 3.  The FreeStyle CoPilot System Home Page: User Profile Menu
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2.	   The Profile for: screen displays with the User Information tab selected. 

Figure 4.  User Information 

3.	 Fill in the information you would like to provide. Fields marked with an asterisk (*) must be 
filled in to create a profile. Fields marked with two asterisks (**) must be filled in to enable 
host synchronization. Add information by selecting items from drop-down boxes or by 
typing information. 

4.	 Click Apply to save the information or OK to save and close the screen. 

User  
Information  

Tab
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3.1.2   Health Profile Tab

1.	 Click the Health Profile tab and fill in the items listed under General.

Figure 5.  Health Profile Information

2.	 Click Click here to add a new Condition, and type a condition to add to the list. 
3.	 Click the arrow on the Condition column to display a drop-down list. 

Figure 6.  Condition List

You can:

•     Select any of the conditions listed that apply to you, or 
•     Type in a new condition that will be added to the list. 

4.	  Click Apply to save.
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3.1.3   Data Entry Preferences Tab

You can save time in manually entering data by setting up your Data Entry Preferences. For 
example, if you regularly take a certain type of insulin at a particular dose, you can enter it here. 
The same is true for your regular exercise routines and other medications you may take. The 
information you enter here is listed for you when you go to make manual entries. 

Figure 7.  Data Entry Preferences

1.	 To enter your preferences, select the Data Entry Preferences tab and fill in Exercise 
Preferences (type, duration, intensity); Insulin Preferences (insulin name/type, dosage, 
type); and Medication Preferences (medication name, dosage, number of pills). 
•     �You can type in a new entry that will be added to the list, or select one of the listed 

entries. 
2.	 Click Apply to save. 
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3.1.4   Glucose Targets Tab

1.	 Click the Glucose Targets tab to enter your target glucose ranges. If you don’t know what 
to fill in, ask the HCP who helps you manage your glucose levels. The target ranges you set 
here are displayed in the graph, as well as in many FreeStyle CoPilot system reports. The 
ranges are displayed in unique colors for easy viewing. 

Figure 8.  Glucose Target Ranges Page

2.	 You may view the graph in three modes. Select the desired mode from the Mode list: 
•     Standard: The glucose target ranges you set apply to all glucose readings, regardless of 

when the glucose reading is taken. (For example, target ranges are the same for pre-meal 
readings as for post-meal readings, bedtime readings, etc.)

•     Pre/Post Meal: The glucose target ranges you set for all pre-meal readings can be 
different from the target ranges for all post-meal readings.

•     All Time Periods: The glucose target ranges you set can be different for each time 
period listed: Pre-Bkfst, Post-Bkfst, Pre-Lunch, Post-Lunch, Pre-Dinner, Post-Dinner, 
Bed, and Sleep.
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Figure 9.  Glucose Targets, Mode Selection

You should set glucose targets in all three modes to take best advantage of the reports the 
FreeStyle CoPilot system creates. For a table of the reports that use glucose targets and the 
modes they use, see Section 5.4: Glucose Target Modes.

Note:	 The glucose targets mode you select here will become the default and will display in all 
the reports that use glucose targets. To change the mode, return to the Glucose 
Targets screen and select another mode from the Mode list. This will become the 
default until you change it.

3.	 Click on the up/down arrows for High and Low to set your glucose targets. To restore 
Glucose Target Ranges to the default ranges, click Restore Defaults.

Note:	 Clicking Restore Defaults also restores the mode to Standard Mode and un-checks 
the Use Hypo/Hyper Values box. 
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Figure 10.  Pre/Post Meal Mode with Hypo/Hyper Checked (left); 
	 All Time Periods Mode (right)

4.	 Check the Use Hypo/Hyper Values box to activate the Very Low and Very High data 
fields.

Figure 11.  Hypo/Hyper Values Check Box

Note:	 The Glucose Unit of Measure is fixed at mg/dL in the United States version of the 
FreeStyle CoPilot system.

5.	 Click the up/down arrows for Very Low and Very High to change these values. 
6.	 To customize the Time Periods to your normal daily schedule, click the up/down arrows 

next to a time period (for example, Pre-Bkfst, Post-Bkfst, Sleep, etc.) to change the time. 
To restore all Time Periods to the times shown here (the defaults), click Restore Defaults.

IMPORTANT:	 Please customize your Time Periods before entering data into the FreeStyle 
CoPilot system. If the Display Time Periods setting is turned on for the 
Glucose Modal Day Report, changing the Time Periods after data has been 
entered will result in the data appearing based on the Time Periods. This 
may result in data not corresponding to the event times.
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Figure 12.  Time Periods

Note:	 The FreeStyle CoPilot system will not allow you to enter a normal daily schedule that 
exceeds 24 hours. If you try, you will receive an error message. Readjust the time periods 
to equal 24 hours.

Figure 13.  Time Period Error Message

7.	 Click Apply to save your settings.
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3.1.5   Options Tab

1.	 Click the Options tab. 

Figure 14.  Profile and System Options 

2.	 Under Program Options, check the boxes for the options you want. 

Note:	� You will be able to select Data Entry Options after reviewing Section 4: Entering Data 
into the FreeStyle CoPilot System. You will be able to select Report Options and Favorite 
Report Options after reviewing Section 5: Viewing and Printing Reports. After reading 
these sections, be sure to select only the options that apply to your diabetes 
management. This will simplify your use, entry, and viewing of data/events. 

3.	 Click Apply to save your selections.
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3.2      Home User: Managing Your User Profile

3.2.1   Changing or Updating Your User Profile

1.	 Click  on the Home Page.
2.	 Click the tab you want (User Information, Health Profile, etc.) and change or add 

information as described in Section 3.1: Home User - Profile Setup . Be sure to click Apply to 
save your new or changed data.

3.2.2   Adding a User Profile 

Some households may have more than one home user managing glucose levels. To add 
another home user:

1.	    On the Home Page, select Add User from the File menu. 

Figure 15.  File Menu: Add User

2.	 The Profile for: screen displays with the User Information tab selected. Fill in information as 
described in Section 3.1 - Home User - Profile Setup.
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3.2.3   Removing a User Profile

1.	 Click . The User List screen displays.

Figure 16.  User List 

2.	 Highlight the name of the user you wish to remove. 

3.	 Click  (or select Remove User from the File menu on the User List screen). The system 
will ask you to confirm. If you select Yes, the user is removed.

Note:	 You cannot delete your own user profile. If you try, the FreeStyle CoPilot system displays 
the following error message:

Figure 17.  Error Message
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3.2.4   Adding an HCP Profile

You can create as many HCP profiles as you want. This is often a good way to store names, 
addresses, and other information about your doctors, clinics, etc. The HCPs you add here will 
not have access to your FreeStyle CoPilot system data unless you “invite them to share your 
data” (see Section 7.4: Invitation to Share Data for more information).

To add an HCP:

1.	 From the File menu on the menu bar, select Add HCP. 

Figure 18.  File Menu: Add HCP Command

2.	 The Profile for: screen displays.

Figure 19.  HCP Profile 

3.	 Select a description of the HCP from the HCP Type list.

Figure 20.  HCP Type List
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•     Select the type of HCP from the list.
•     If you don’t see the one you want, type in a description (for example, Case Manager).

4.	  If you know it, fill in the rest of the information for the HCP.
5.	 Click OK to save the information and exit.

3.2.5   Editing an HCP Profile

1.	 Click UserProfile > HCP List. 

Figure 21.  UserProfile Menu: HCP List Command

2.	  The HCP List screen displays. Highlight the name of the HCP User. 

Figure 22.  HCP List 

3.	 Click  (or select Edit HCP Profile from the File menu). The Profile for: screen for the HCP 
User displays. 

4.	 Make your edits on the screen. When done, click OK.

3.2.6   Removing an HCP Profile 

1.	 Click UserProfile > HCP List. 
2.	 Highlight the name of the HCP User on the HCP List screen. 

3.	 Click  (or select Remove HCP from the File menu). The FreeStyle CoPilot system will 
ask you to confirm. If you select Yes, the HCP User is removed.
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3.3      HCP - Setting Up Your User Profile

This section explains how to create and use HCP profiles. It describes the three parts of the HCP 
profile (called Tabs) - User Information, Glucose Targets, and Options. Each tab is a form that 
you fill out using open text fields, drop-down lists, and check boxes. This section describes how 
the settings, preferences and options you choose affect how the FreeStyle CoPilot system 
works and the appearance of reports you use. 

This section also explains how to set up and manage other HCP profiles, as well as patient 
profiles.

Note:	 The home user profile is displayed (labeled) in the home user version of the FreeStyle 
CoPilot system as User Profile. The home user profile is displayed (labeled) in the HCP 
version as Patient Profile. 

3.3.1   What is an HCP Profile?

Each HCP should set up and use an individual HCP profile. The HCP profile contains professional 
contact information that is important for using the FreeStyle CoPilot system Host, and for 
sharing data with other HCPs. 

The HCP profile also provides options and preferences. You can use these to customize how you 
would like to work with patient information, reports, and other application features. 

You can use your profile to specify the following, and more:

•     ��Categories you would like to use when entering patient health information events, such 
as blood ketones, exercise, lab tests, and exams.

•     �Items that you want to see listed when you record patient health information - such as 
medications, exercise, and insulin doses. 

•     �Glucose targets which change how some charts, graphs and reports are displayed.
•     �Whether to automatically print your favorite report(s) when you upload glucose meter 

or other device readings.
•     �The default date-range you would like to see in reports such as last 7 days, one month, or 

three months.

Note:	 Preferences and settings in the HCP profile affect your use of the Manual Entry and 
Reports features in the FreeStyle CoPilot system. For more information, read  
Section 5: Viewing and Printing Reports, and Section 4: Entering Data into the FreeStyle 
CoPilot System. 
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3.3.2   HCP Profile Setup

Figure 23.  HCP Home Page

1.	 Click UserProfile > HCP Profile.

Figure 24.  HCP: UserProfile Menu

2.	 The HCP Profile for: screen displays with the User Information tab selected. 
3.	 Fill in the information you would like to provide. 

•     Add information by selecting items from drop-down boxes or typing information. 
•     Fields marked with an asterisk (*) must be filled in to create a profile. Fields with two 

asterisks (**) must be filled in to enable host synchronization.

Select Patient  
List

Select HCP  
List
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Figure 25.  HCP User Information Page

4.	 If you don’t see your HCP type in the HCP Type list, you can type a description.
5.	 Click Apply to save the information you filled in, or click OK to save the information.

3.3.3   Automatic Report Printing

When you fill in information for a new profile and click Apply, the FreeStyle CoPilot system asks 
you if you would like to enable automatic printing of reports for all devices after data upload 
using Read Device.

•     Click Yes or No.

Figure 26.  Automatic Printing Option

Note:	 You can enable this option at any time, in the Options tab of your profile. 
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3.3.4   Glucose Targets Tab

1.	 Use the Glucose Targets tab to customize glucose target ranges. The glucose targets you 
set here change the display of tables, charts and graphs. See Section 5.4: Glucose Target 
Modes, for a list of reports that use glucose targets, the modes they use, and ones that you 
can change.

Figure 27.  Glucose Targets Page: Standard Mode

2.	 You may view the graph in three modes. Select the desired mode from the Mode list. 

Figure 28.  Glucose Targets Mode List

You should set glucose targets in all three modes to take best advantage of the reports the 
FreeStyle CoPilot system creates.

•     �Standard: The glucose target ranges you set apply to all glucose readings, regardless of 
when the glucose reading is taken. (For example, target ranges are the same for pre-
meal readings as for post-meal readings, bedtime readings, etc.)

•     �Pre/Post Meal: The glucose target ranges you set for all pre-meal readings can be 
different from the target ranges for all post-meal readings.

•     �All Time Periods: The glucose target ranges you set can be different for each time 
period listed: Pre-Bkfst, Post-Bkfst, Pre-Lunch, Post-Lunch, Pre-Dinner, Post-Dinner, Bed, 
and Sleep.
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3.	 Click the up/down arrows for High and Low to set glucose targets. Click Restore Defaults 
to restore Glucose Target Ranges to default settings.

Note:	 The glucose targets mode you select here will become the default and will display in all 
the reports that use glucose targets. To change the mode, return to the Glucose 
Targets screen and select another mode from the Mode list. This will become the 
default until you change it.

Figure 29.  All Time Periods Mode

Figure 30.  Pre/Post Meal Mode
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4.	 To display Hypo (low) and Hyper (high) glucose values, check Use Hypo/Hyper Values. 
Optionally, adjust Very Low and Very High values. 

Figure 31.  Hypo/Hyper Values 

Note:	 The Glucose Unit of Measure is fixed at mg/dL in the United States version of the 
FreeStyle CoPilot system.

5.	 Click Restore Defaults to restore default glucose target range values, including Hypo/
Hyper values.

6.	 Click Apply to save your settings.
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3.3.5   Options Tab

1.	 Select the Options tab. 

Figure 32.  HCP Profile Options Page

2.	 Under Program Options, check the boxes for the options you want. 

Note:	 You will be able to select Data Entry Options after reviewing Section 4: Entering Data 
into the FreeStyle CoPilot system. You will be able to select Report Options and Favorite 
Report Options after reviewing Section 5: Viewing and Printing Reports. Setting these 
options can save time when patients arrive for clinic visits. For example, your preferred 
reports can be set to print whenever a device is uploaded to the FreeStyle CoPilot 
system.

3.	 Click OK to save your selections and return to the Home page.
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3.4      HCP - Managing the HCP Profile

3.4.1   Changing or Adding to Your HCP Profile

1.	 From the Home page, select HCP Profile from the UserProfile menu. 

Figure 33.  UserProfile, HCP Profile Menu

2.	 On the HCP Profile for: screen, select the tab you want (User Information, Glucose Targets, 
Options) and change or add information as described in Section 3.3:  HCP - Setting Up Your 
User Profile. Be sure to click Apply to save your new or changed data.

3.4.2   Adding a Patient Profile

1.	 Click . The Patient List screen displays.

Figure 34.  Patient List 

2.	 Click . The Patient Profile for: screen displays. The form is similar to the form you filled in 
to set up your HCP profile.
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Figure 35.  Patient Profile Page 

3.	 Fill in the information you can provide on the Patient Information tab. 
•     Add information by selecting items from drop-down boxes or typing information. 
•     Fields marked with an asterisk (*) must be filled in to create a profile. 

4.	 Click Apply to save the information you filled in. 

Health Profile Tab

Click the Health Profile tab. Fill out the Health Profile screen as described in Section 3.1.2: 
Health Profile Tab.

Data Entry Preferences Tab

You can save time in manually entering data by setting up your patient’s Data Entry Pref
erences (if you know them). For example, if a patient regularly takes a certain type of insulin at a 
particular dose, you can enter it here. The same is true for their regular exercise routines and 
other medications they may take. The information you enter here is listed for you when you go 
to make manual entries.

Click the Data Entry Preferences tab. Fill out the preferences for the patient as described in 
Section 3.1.3: Data Entry Preferences Tab.
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Glucose Targets Tab

Click the Glucose Targets tab. Fill out the glucose targets for the patient as described in Section 
3.1.4: Glucose Targets Tab. The glucose targets that you define in your own (HCP) profile are used 
as parameters in the reports, charts and graphs that you view. The glucose targets that you 
define in a patient profile are reflected in reports, charts and graphs that your patient sees 
when they use the FreeStyle CoPilot system.

3.4.3   Editing a Patient Profile 

1.	 Click . The Patient List screen displays. Highlight the name of the patient. 

Figure 36.  Patient List 

2.	 Click  (or select Edit Patient Profile from the File menu on the Patient List screen). 
3.	 The Patient Profile for: screen for that patient displays. Make your edits on the screen. 
4.	 Click OK. 

3.4.4   Removing a Patient Profile 

1.	 Click . The Patient List screen displays. 
2.	 Highlight the name of the patient you wish to remove. 

3.	 Click  (or select Remove Patient from the File menu on the Patient List screen). The 
system will ask you to confirm. If you select Yes, the patient is removed.
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3.5      Managing HCP Profiles

3.5.1   Adding an HCP Profile

1.	 Click File > Add HCP. 

Figure 37.  File Menu, Add HCP Command

2.	 The HCP Profile for: screen displays. 
3.	 Fill in the fields as described in Section 3.3, HCP - Setting Up Your User Profile. 
4.	 Click OK.

3.5.2   Assigning an HCP 

1.	 Click . The Patient List screen displays. 

2.	 Click . 

3.	 On the next screen, click Assign Patients to: and select the HCP from the list. 

Figure 38.  Assign Patients Drop-down List

4.	 Highlight the name of the patient you want to assign to this HCP and select the Access 
Level (None, Read Only, Full, Owner) for the HCP.

Figure 39.  Access Levels

5.	 Click OK.
Note:	   For more information about Access Levels, see Section 9: Security.
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3.5.3   Editing an HCP Profile

1.	 Click UserProfile > HCP List. The HCP List screen displays.

Figure 40.  HCP List 

2.	 Highlight the name of the HCP User. 

3.	 Click  (or select Edit HCP Profile from the File menu on the HCP List screen). 
4.	 Make your edits on the HCP Profile for: screen. Click Apply, then OK. 

3.5.4   Removing an HCP Profile

1.	 Click UserProfile > HCP List. The HCP List screen displays.
2.	 Highlight the name of the HCP User you wish to remove. 

3.	 Click  (or select Remove HCP from the File menu on the HCP List screen). 
4.	 The FreeStyle CoPilot system will ask you to confirm. Click Yes to remove the HCP. 
5.	 If local patients are assigned to this HCP, the FreeStyle CoPilot system prompts you to 

reassign the patients to another HCP on the local computer:

Figure 41.  Reassign Local Patients Message

6.	 Click OK. Reassign the HCP’s patients to another HCP as described in Section 3.5.2, Assigning 
an HCP.

7.	 After reassigning the patients, follow Steps 1 through 4 (above) to remove the HCP.
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4   Entering Data Into the FreeStyle 
CoPilot system
There are three ways to enter events (data) into the FreeStyle CoPilot system. Each of these 
methods is explained in the corresponding section, below.

•     Uploading Data from a Device 
•     Manual Data Entry
•     Importing Data from Database Files

This section also explains how to export data.

CAUTION:	 The FreeStyle CoPilot system assumes a single glucose calibration type, either 
plasma or whole blood.

4.1      Uploading Data from a Device

Use the FreeStyle CoPilot system to upload data from all supported Abbott Diabetes Care blood 
glucose monitoring systems. For a list of supported devices, see Appendix C: Supported Devices 
and Databases. 
Data from the Deltec Cozmo Insulin Pump and the FreeStyle Navigator System can be directly 
uploaded to the FreeStyle CoPilot system by installing the appropriate software for these 
devices where available. For more information, view the User’s Guide provided with each 
device. 
You can also import data from CoZmanager, the software program for storing CozMore System 
data where available. For more information, see Section 4.4: Importing Data from Database Files.

IMPORTANT:	 To avoid losing data, upload data from your device often. Most devices hold 
only a limited number of historical records. 

4.1.1   Connecting a Device to Your Computer

Before uploading, you must connect the device to an available COM port or USB port on your 
computer using an approved data cable for that device. 

•	 One end of the data cable attaches to the device; the other end attaches to the 
computer. 

•	  The connectors on the data cable will fit only into the appropriate ports on the PC and 
monitoring device. 

WARNING:
•	 To avoid the possibility of electrical shock, never perform a blood glucose test while the 

meter is connected to the computer.
CAUTION:	 Ensure that the time and date are set correctly on your personal computer and 

other devices. 
IMPORTANT:	 Always refer to the user’s guide that came with your device or pump for 

complete instructions on its use.
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4.1.2   Uploading from a Device and Saving to a Profile

To upload and print reports without saving to a profile, see Section 4.1.5: Quick Print.

IMPORTANT:	 Any data you previously uploaded from a device will not be overwritten when 
you upload again from that same device. Only the new data will be added to 
your file.

Connect the device to the computer.

1.	 On the Home page, select the user whose data is being uploaded from the device.
2.	 Click DataEntry on the menu bar; and select Read Abbott BG Meter (Or, click the Read 

Device button on the Home page).

Figure 42.  DataEntry Menu: Read Abbott BG Meter

CAUTION:	 When uploading glucose data from a device, the FreeStyle CoPilot system does 
not differentiate between devices that are whole-blood or plasma calibrated. 
The FreeStyle CoPilot system merely uploads the data with no calculations 
made. Because there are slight differences between the two calibrations, you 
should not mix data from devices that use different calibration references. It is 
possible to enter duplicate data entries into the FreeStyle CoPilot Health 
Management System.

	 The FreeStyle CoPilot system does not check the accuracy of the data the user 
provides. For example, a user of the Deltec Cozmo insulin pump might record 
the carbohydrates for a meal (for example, 25 g) and enter it into the Deltec 
Cozmo software. When the user uploads the data from the pump, a meal entry 
(25 g) will be created in your FreeStyle CoPilot system. If the user also manually 
enters a meal entry (25 g) for that same meal in the FreeStyle CoPilot system 
Software, two meal entries would result (at slightly different times), thereby 
accidentally recording a total of 50 g for the meal. The user must take reasonable 
precautions to prevent duplication errors. For example, choose one location for 
recording certain data types (i.e., on a single device or in a particular software 
program).
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Note:	 When a device has been detected but cannot be identified as belonging to a specific 
user, the FreeStyle CoPilot system will prompt you to assign the device to an existing 
user or to add a new user: 

Figure 43.  Assign Device Dialog

CAUTION:	 Do not upload data from any device that has recorded data for more than one 
person. The FreeStyle CoPilot system cannot identify if data on a device has ever 
been recorded for more than one person. All data stored on a device is uploaded 
to the database for the person associated with the device in the FreeStyle CoPilot 
system. 

3.	 The data from the device is uploaded to your PC. A fully filled progress bar indicates when 
the upload is complete. A summary of the upload displays in a pop-up window. Press OK to 
continue.

Figure 44.  Upload Summary 

Note:	 If you receive an error message, check the device connection. Also, click DataEntry > 
Assign Default Device to verify the device setting. After the first upload from a device, 
the FreeStyle CoPilot system will identify that device and associate it with the assigned 
user. 

Note:	 More than one device may be associated with a single user.
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4.1.3   Undoing a Device Upload

You can delete (undo) the data uploaded from the most recent device that was newly assigned 
to a user as long as you have not selected another user, closed the application, or performed a 
Quick Print (see Section 4.1.5: Quick Print).

1.	 Click DataEntry on the menu bar; and select Undo Upload. 

Figure 45.  DataEntry Menu: Undo Upload

2.	 The FreeStyle CoPilot system will undo your last upload from a newly assigned device.

Note:	 If Undo Upload is gray, you cannot undo the last upload.

4.1.4   Data Transfer between Patient Profiles (HCPs Only)

If data was uploaded from a device into an incorrect patient profile, you can transfer the
data associated with that device into the correct patient profile. The device association will also 
be reassigned to the correct patient profile.

Note:	 The data transfer will only occur in the local database, not on the Host System. If you 
have uploaded data into an incorrect patient profile and subsequently performed 
synchronization with the FreeStyle CoPilot Host (see Section 7: Sharing Data with the 
FreeStyle CoPilot Host), please contact Abbott Diabetes Care Customer Care for 
assistance (see Appendix A: Contact Customer Care).

Transferring Data between Patient Profiles:
1.	� On the Home page, select the HCP and Patient from which to transfer data (the Patient 

Profile selected here is referred to as the Source Profile).
2.	� Click UserProfile > Patient List. The Patient List screen displays.
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3.	� The selected patient profile from the Home page is highlighted. To select a different Source 
Profile, click on the patient name to highlight it.

4.	 Click the  Transfer Data Between Patients button. If you have previously synchronized 
with the FreeStyle CoPilot Host, a message will appear informing you that the data transfer 
occurs in the local database only. Click OK to continue. 

Figure 46. Patient List: Data Transfer

5.	 In the Transfer From list, select the device that was uploaded to an incorrect patient profile.
6.	 In the Transfer To list, select the Patient to transfer the data to (the Patient Profile selected 

here is referred to as the Target Profile). Note: The Data Transfer can only be performed 
between patient profiles assigned to the same HCP.

7.	 Click OK.

Figure 47. Data Transfer Confirmation

8.	 A confirmation message will appear asking you to confirm the data transfer. Click OK to 
continue.

9.	 If the data transfer was successful, a message will appear indicating that the data transfer 
had completed successfully.
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4.1.5   Quick Print

Quick Print will upload your device data and automatically print the selected Favorite Reports without 
having to create a new user/patient profile. See Section 5.3.1: Report Options (User or HCP Profile) for 
instructions to select your Favorite Reports to print.

Note:  If you had an earlier version of the FreeStyle CoPilot system (version 4.1 or earlier) installed, the 
Favorite Reports that you had previously selected may need to be selected again.

Note:  Any data you upload using Quick Print will not be permanently saved to a profile.  The uploaded 
data will only be temporarily stored in a Guest profile until one of the following events occurs:

•	 Uploading data from a device

•	 Switching to a different user/patient profile

•	 Synchronizing with the FreeStyle CoPilot Host (see Section 7: Sharing Data with the FreeStyle 
CoPilot Host)

•	 Logging off or closing the FreeStyle CoPilot system

In addition, any reports that are open on the screen will be immediately closed when you use Quick 
Print.

To upload and save data to a profile, see Section 4.1.2: Uploading from a Device and Saving to a Profile.

To use Quick Print:

Connect the device to the computer.

1.	 On the Home page, click the 	 Quick Print button.  (Or, click DataEntry > Quick 
Print Abbott BG Meter from the menu bar.)

Note:	 To use Quick Print for other supported Abbott Diabetes Care blood glucose monitoring 
systems that require the installation of additional software for those devices (e.g. 
FreeStyle Navigator System), you must click the corresponding DataEntry > Quick 
Print <device> from the menu bar.

2.	 As the data from the device is uploaded, a screen appears indicating the data upload progress and 
print status.  When the reports have completed printing, the Home page will be displayed.
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4.2      Manual Data Entry

The FreeStyle CoPilot system allows you to add, edit, hide, and unhide manually entered 
information. When manually recorded events are hidden, they are omitted from views and 
reports but are not removed from your database. 

WARNING:
•	 Be sure to enter and check all values carefully. The FreeStyle CoPilot system cannot 

check that the entries you make are correct for your personal needs. Serious effects on 
your health could result from relying on or using improper or incomplete entries. 
Discuss the data entry options available with your HCP so you are both clear on the 
amount and types of information for therapy analysis.

CAUTION:	 It is possible to enter duplicate data entries into the FreeStyle CoPilot Health 
Management System. The FreeStyle CoPilot system does not check the accuracy 
of the data the user provides. For example, a user of the Deltec Cozmo insulin 
pump might record the carbohydrates for a meal (for example, 25 g) and enter it 
into the Deltec Cozmo software. When the user uploads the data from the pump, 
a meal entry (25 g) will be created in your FreeStyle CoPilot system. If the user 
also manually enters a meal entry (25 g) for that same meal in the FreeStyle 
CoPilot system Software, two meal entries would result (at slightly different 
times), thereby accidentally recording a total of 50 g for the meal. The user must 
take reasonable precautions to prevent duplication errors. For example, choose 
one location for recording certain data types (i.e., on a single device or in a 
particular software program). 

Manually recordable events include the categories listed below. Their icons are pictured with 
them. These icons are displayed in the Diary List to represent the type of event on the list; see 
Section 5.6.3: Diary List.
 

Icon Event

Glucose reading

Glucose Control reading

Bolus Insulin

Meal

Exercise
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State of health

Medication

Medical exam

Lab Test result

Ketones (Blood)

Ketone Control readings

Notes (miscellaneous events, etc.)
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4.2.1   Entering a Glucose Reading

1.	 Click the large Manual Entry button . The Data Entry screen for entering a Glucose 
Reading displays.

Figure 48.  Glucose Reading Data Entry 

2.	 If the date, time, and time period of the glucose reading is different from the current display, 
adjust the Date, Time, and Time Period.

3.	 Record the value of your glucose reading in the Glucose Value field. 
4.	 Optionally:

•     �In the Sample Site field, select the site from which the reading was taken (finger, 
forearm, etc.).

•     In the Hours Since Last Meal field, select the time of your last meal.
•     �If you wish, enter the calibration code from your glucose monitor in the Calibration Code 

field.
•     �If this is a Control Solution reading from your glucose monitor, check the Control 

Reading box.
•     Enter any comments you may have about the reading in the Comment field.

5.	 Because you are entering data at the keyboard, the Data Source is set to Manual. 
6.	 Click Apply to save your data. 
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4.2.2   Recording an Insulin Dose

CAUTION:	 Contact your healthcare professional for guidance on determining and using 
your insulin dosages, insulin-to-carbohydrate ratios, and insulin sensitivities.

1.	 Click the Insulin icon  on the Data Entry screen. The Bolus Insulin data entry screen 
displays.

Figure 49.  Insulin Data Entry 

2.	 Adjust the Date, Time, and Time Period fields for the insulin dose you are recording.
3.	 In the Insulin Name/Type list, select the correct insulin type: Short-Acting, Rapid-Acting, 

Intermediate, Long-Acting, Pre-Mix or Inhaled.

Note:	 To add items to the Insulin Name/Type list, refer to Section 3.1.3: Data Entry Preferences 
Tab. Also, to add or hide items, see Section 4.3: Customizing Data Lists.

4.	 Type or select the correct dosage in the Dosage (Units) column.
5.	 In the Injection Type list, select the correct Injection type: bolus, injection, meal, 

correction, combination, dual wave, or square wave. 
6.	 Optionally, add a comment in the Comment box.
7.	 Click Apply to save, or OK to save and close the Data Entry screen.
8.	 The entry is added to the Diary List. 
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4.2.3   Recording a Meal

CAUTION: 	 Contact your healthcare professional for guidance on determining and using 
your prescribed carbohydrate intake.

Note:	 If a version of the FreeStyle CoPilot system (version 3.1 or earlier) was installed prior to 
installing an upgrade to the FreeStyle CoPilot system, the Food Item list is filled with 
items. Installation of the FreeStyle CoPilot system (version 4.0 or later) does not include 
items in the Food Item list. If the Food Item list is present, the Carbs and Total Carbs 
automatically display when you select an item from the list.

1.	 Click the Meal icon on the Data Entry screen. The Meal data entry screen displays.

Figure 50.  Meal Data Entry 

2.	 Adjust the Date, Time, and Meal fields for the meal you are entering.
3.	 Enter a new item, or select an existing item, in the Food Item list. If your meal includes 

more than one item (drink, main course, fruit, etc.), list each item in the Food Item list.

Note:	   You will need to know the serving size and the carbohydrates per serving.

•     Svgs: Select the number of servings.
•     Carbs (g): Enter the grams of carbohydrates per serving.

•     Total Carbs (g): Total  grams of carbohydrates.
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Figure 51.  Multi-Item Meal with Total Carbohydrates Shown

4.	 Check the Use Only Favorite Foods  to display your list of favorite foods. 

Note:	   To customize items in the Food Item list, see Section 4.3: Customizing Data Lists.

5.	 Enter any comments in the Comment box (optional).
6.	 Click Apply to save the new information. The entry will appear in your Diary List.

Total Carbs for a 
multi-item meal
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4.2.4   Recording Exercise Activity

1.	 Click the Exercise icon  on the Data Entry screen. The Exercise data entry screen 
displays.

Figure 52.   Exercise Data Entry

2.	 Adjust the Date, Time, and Time Period fields for the exercise activity you are entering.
3.	 Enter an activity, or select an existing activity (jogging, biking, etc.) in the Type list. 

Note:	 To customize (add or hide) items in the Exercise list, refer to instructions in Section 3.1.3: 
Data Entry Preferences Tab. Also, see Section 4.3: Customizing Data Lists.

4.	 Select the Duration, and Intensity of the activity.
•     Duration: Length of activity (in minutes and hours: 0:30, 1:15, etc.). You can select from 

the list or type in the duration of the activity. 
•     Intensity: Intensity of the activity (none, low, medium, or high).

Note:	 Confirm that the box  next to the entry  is checked. Otherwise, the data will not be 
recorded and will not appear on your Diary List.

5.	 Enter any comments in the Comment box (optional).
6.	 Click Apply to save the new information. The entry will appear in your Diary List.
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4.2.5   Recording State of Health

1.	 Click the Health icon  on the Data Entry screen. The State of Health data entry screen 
displays.

Figure 53.  State of Health Data Entry 

2.	 Adjust the Date and Time fields for the health condition you are recording.
3.	 Select an item, or enter a new item in the State of Health list.
4.	 Use the Comment box to further describe your condition (optional).
5.	 Click Apply to save. The entry will appear in your Diary List. 
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4.2.6   Recording a Medication Event

1.	 Click the Medication icon on the Data Entry screen. The Medication data entry screen 
displays.

IMPORTANT:	 Medication Event refers to all medications you take except insulin.

Figure 54.  Medication Data Entry 

2.	 Adjust the Date, Time, and Time Period fields for the medication event you are recording.
3.	 Select an item, or enter a new item in the Medication list.

Note:	 To customize (add or hide) items in the Medication list, refer to instructions in Section 
3.1.3, Data Entry Preferences Tab. Also, see Section 4.3: Customizing Data Lists.

4.	 Type in the dosage (for example, 2 mg) in the Dosage column. If you don’t know the 
dosage, check the medication bottle or ask your HCP. 

5.	 Select the number of pills you take from the # of Pills list. 

Note:	 Confirm that  the box next to the entry is checked. Otherwise, the data will not be 
recorded and will not appear on your Diary List.

6.	 Enter any comments in the Comment box (optional).
7.	 Click Apply to save the new information. The entry will appear in your Diary List.
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4.2.7   Recording a Medical Exam/Doctor Visit

1.	 Click the Exam icon  on the Data Entry screen. The Medical Exam data entry screen 
displays.

Figure 55.  Medical Exam Data Entry 

2.	 If necessary, adjust the Date for the medical exam you are recording.
3.	 In the Exam Type list, select the type of exam or doctor visit you are recording. If the lab 

test is not listed, type in a description.

Note:	 To customize items in the Medical Exam list, see Section 4.3: Customizing Data Lists.

4.	 If you know it, type the name of the HCP into the Examined By field.
5.	 Enter any comments in the Comment box (optional).
6.	 Click Apply to save the new information. The entry will appear in your Diary List.
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4.2.8   Recording a Lab Test Result

1.	 Click the Lab icon  on the Data Entry screen. The Lab Test Result data entry screen 
displays.

Figure 56.  Lab Test Result Data Entry 

2.	 If necessary, adjust the Date for the lab test result you are recording.
3.	 From the Test Type list, select the type of lab test you had (for example, Cholesterol LDL). 

If the lab test is not listed, type it in.

Note:	   To customize items in the Lab Test Result list, see Section 4.3: Customizing Data Lists.

4.	 If you know the Result Value, the Units, and the Reference Range for the lab test you had, 
type the information into the appropriate fields. 

IMPORTANT:	 Be careful to type numbers only into the Result Value field. For example, if your 
A1C test result is 7.6%, type 7.6 in the Result Value field and type % in the 
Units field. If you type the units in the Result Value field, the entry for this lab 
test will not be displayed correctly in the reports you generate.

5.	 Enter any comments in the Comment box (optional).
6.	 Click Apply to save the new information. The entry will appear in your Diary List.



Back to Table of Contents 	 57

Section 4: Entering Data Into  
the FreeStyle CoPilot System

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

4.2.9   Recording a Ketone Reading

1.	 Click the Ketones icon in the Data Entry screen. The Ketones (Blood) data entry screen 
displays.

Figure 57.  Ketones (Blood) Data Entry 

2.	 If necessary, adjust the Date, Time, and Time Period fields for the ketone reading you are 
recording.

3.	 Enter the result of the ketone reading in the Value (mmol/L) field. 
4.	 From the Sample Site list, select the sample site.
5.	 Type in the ketone Lot Number, if you know it. 
6.	 Check the Control Reading box if this is a control reading.
7.	 Enter any comments in the Comment box.
8.	 Click Apply to save the new information. The entry will appear in your Diary List. 
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4.2.10   Recording a Note (or Miscellaneous Event)

1.	 Click the Note icon in the Data Entry screen. The Notes data entry screen displays.

Figure 58.  Notes Data Entry 

2.	 If necessary, adjust the Date, Time, and Time Period fields for the information you are 
recording.

3.	 Type your note or information about a miscellaneous event in the Comment box.
4.	 Click Apply to save the new information. The entry will appear in your Diary List.
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4.3      Customizing Data Lists

To make manual data entry faster and easier, you can customize items in the lists. You can:

•     Add new items to lists
•     Hide items that you want keep in a list but do not want to see
•     Designate favorite food items

Items you add to a list are marked with the User Entry icon . Items provided by the 
FreeStyle CoPilot system are marked with .

Note:	 The Food Items list is pre-filled with items if you had an earlier version of the FreeStyle 
CoPilot system (version 3.1 or earlier) installed before installing an upgrade to the 
FreeStyle CoPilot system. If you install the FreeStyle CoPilot system (version 4.0 or later) 
without having an earlier version of the FreeStyle CoPilot system installed, there are no 
items in the Food Items list.

4.3.1   Customize Data Entry Lists

Note:	 This procedure provides instructions for customizing the Test Types list. Use the same 
procedure (modified as required) to customize other lists in Customize Data Entry 
Lists. 

1.	 Click DataEntry > Customize Data Entry Lists.

Figure 59.  Customize Data Entry Lists

2.	 The Customize Data Entry Lists screen displays. Select Test Types (or other desired list) from 
the Select List to Customize list.

Figure 60.  Select List to Customize List
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3.	 Add an item to the list. Type the name of the test under the Item heading (for example, 

Serum theophylline level). The User Entry icon  appears next to the new entry. 

Figure 61.  Test Types List

4.	 Check the Hide box for items that you don’t want to see listed when you record a manual 
entry event.   For the Food Item list you can also mark an item as a favorite.

5.	 Click Apply to save the new list item(s).
6.	 Select another list from Select List to Customize, or click OK to close.
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4.4      Importing Data from Database Files

You can import some databases from other programs into your FreeStyle CoPilot system using 
the Import function.

4.4.1   Importing a Database

Some databases can be imported directly into the FreeStyle CoPilot system. They include 
databases created by:

•     FreeStyle Connect Data Management System
•     Precision Link Diabetes Data Management System (V. 2.5 or higher)
•     CoZmanager System

Databases from these programs are detected by the FreeStyle CoPilot system as long as the 
software for the programs that created them are installed on your PC. Otherwise, you may need 
to browse for the database to import by selecting DataEntry > Import > Browse for File on 
the menu bar.

Note:	 The CoZmanager System software must be Rev. D or higher. The internal Deltec Cozmo 
pump software must be Rev. F or higher. The FreeStyle CoPilot system detects the 
software revisions and will not allow the import if it detects the wrong revision(s). 

WARNING:    
•	 Imports from the CoZmanager System include data only from full days (24 hours), not 

partial days. This is so that CoZmanager can provide daily totals.

4.4.2   Importing a Supported Database

1.	 From the menu bar, select DataEntry > Import, then select the database file you want  
to import.

Figure 62.  DataEntry Menu; and Import Menu

2.	 If the database is detected, you will be asked to confirm the import operation.  Otherwise, if 
the database is not detected, the file browser window will open to allow you to select the 
database file to import.



Back to Table of Contents 	 62

Section 4: Entering Data Into  
the FreeStyle CoPilot System

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

4.4.3   Importing Data from a File

You can import a *.tab or *.xml file after the file is specially formatted for the FreeStyle CoPilot  
system by following the instructions provided in the FreeStyle CoPilot System Import/Export 
Guide for importing TAB and XML data.  
You can download this guide from the Abbott Diabetes Care website  
(www.AbbottDiabetesCare.com). 

Perform the following steps to import a *.tab or *.xml file:

1.	 Select the profile that you want to import data into.
2.	 From the menu bar, select DataEntry > Import > Import Events From File.

Figure 63.  Import Menu: Import Events From File

3.	 When the file browser window opens, select the file type (*.tab or *.xml) and the file to 
import, then click Open.
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4.5      Exporting Data

Exporting data in the FreeStyle CoPilot system is similar to archiving data see Section 8.1: 
Archiving Data except that the exported data is not removed from the FreeStyle CoPilot system’s 
database.

To export data: 

1.	 Click Reports on the menu bar; then select Diary List.

Figure 64.  Reports Menu

2.	 The Diary List displays.
3.	 Adjust the date to include the data you want to export.

Figure 65.  Diary List: Date Adjustment

4.	 Click Export from the File menu on the Home page. When the file browser window opens, 
select the folder where you want to save the file that is exported.

5.	 Select the file type (*.tab or *.xml) in the Save as type field.
6.	 Enter the name of the file in the File name field. Click Save.
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5   Viewing and Printing Reports
With the FreeStyle CoPilot system, data entered manually or uploaded from a device can be 
displayed on the screen in a variety of ways. Statistical and other calculations are automatically 
performed on the data, and the results are put into tables and graphs. A report is one or a set of 
these tables and graphs. 

Figure 66.  Glucose Modal Day Report

Any report can be customized to your preferences. Many variables can be adjusted in real time 
as you view the report. These are described in Section 5.3 - Personalizing Report Settings. 

Data cannot be changed in any reports except the Diary List. Corrections or additions to 
manually entered data can be made by accessing the Data Entry screen for the event. Refer to 
the individual report sections for instructions on calling up the Diary List entry for past events. 
The changes display immediately on any affected report.

Once opened, a report remains open until you close it. Any number of reports can be open at 
the same time; only one is visible. Each open report shows as a tab at the top of the screen. 

All open reports apply the same active date range, data filter options, and display features. 
Changing these settings in any report changes them for all other open reports.

Reports
Toolbar
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CAUTION:	 For glucose and insulin entries, if the Time Period is changed manually, all reports 
will still be displayed as defined by the Time Period setting in the User Profile.

Note:	 Any decimal calculations that are 0.4 or less are rounded to 0. Any decimal calculations 
that are 0.5 or greater are rounded to 1.

5.1      Viewing Reports 

See Section 5.3.1: Report Options (User or HCP Profile) for instructions to select your default report 
and date range interval. 

1.	 To open the default report from the Home page, click  the View Report button. 
2.	 To open another report, select its name from the Reports menu. The first report remains 

open but hidden, except for its tab. The new report displays with the same date range, active 
data filters, and display features. 

Figure 67.  Reports Menu

3.	 To display a report, click the desired tab on the reports tab bar.

Figure 68.  Reports Tab Bar

4.	 To close the active report, click the Close Report icon  on the reports tab bar.

When you view reports, you can select the date or Date Range for information to view, and you 
can use interactive Data Symbols to see more detailed information.
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5.1.1   Date Range

Use controls on the Reports Toolbar to select the date range (time period) for the information 
that you want to view in one or more reports. You can select a pre-selected time period, and 
you can also select custom dates and date-range intervals. 

Figure 69.  Reports Toolbar

To select the date or date range for information you want to view, use one or more of the 
following tools:

Custom Date Range List - Select any time period (such as Last 1 Month or Last 3 Months) 
in the Custom Date Range List. The dates for your selected date range are automatically 
entered in the Calendar Date Selection Tool.

Figure 70.  Custom Date Range, Calendar Date Selection, and Arrow Tools

Calendar Date Selection - To select a specific date range, enter dates in the calendar range 
selection tool. You can type in the date(s) in the format: mm/dd/yyyy (or dd/mm/yyyy 
depending on your operating system), or you can use the down arrows to open the 
calendar. Use the left and right arrows above the calendar to select the month and year. 
Highlight any day in the calendar.

Previous and Next Arrows - After you have selected a date range, use the previous and 
next arrows to “jump” or “scroll” back or forward in time. For example, if you have selected 
the Last 7 days date range (such as from May 1 to May 7), you can click the previous arrow to 
change the date range seven days earlier. The same effect occurs forward and backward for 
any date range interval, whether days or months.
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5.1.2   Data Symbols 

You can use the symbols used in reports to link to related or more complete information. 
Interactive data symbols include data points on a graph, regions on a chart, and cells in a table. 

Your pointer becomes the hand icon when it is hovering over an interactive data symbol. For 
example, by hovering the pointer over a triangle (glucose reading data symbol), you can 
display the value, date, and time of the reading in a pop-up field. To go to the Glucose Reading 
event in the Diary List, double-click the triangle. 

On the Daily Combination and Weekly Pump reports:

•    Carbohydrate events are represented by dark yellow circles; the size of each circle is 
proportional to the carbohydrate value.

•    Insulin data is represented by light green, dark green, and dark red bars. 
On all reports (except for the Diary List):

•	 Glucose readings are represented by squares (manual entries), triangles (meter blood 
glucose readings), and circles (continuous glucose readings) which can be linked by a 
line. 

5.1.3   Target Range Colors

Glucose readings are separated into target ranges, which are represented on graphs and tables 
either in distinctive colors or in distinctive patterns for black-and-white printing.

You can display the data in three ranges (High, Within, and Low) or five ranges (Very High, High, 
Within, Low, and Very Low). These choices can be changed at any time on the Miscellaneous 
tab of the Report Configuration form by checking or un-checking the Show Hypo/Hyper 
box. 

Each target range is associated with a unique color: Very High (turquoise), High (purple), Within 
(green), Low (yellow), and Very Low (red).
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5.2      Printing and Sending Reports 

To view a menu of options for printing and sending a report, click the down arrow next to the 
Print icon  on the Reports toolbar. 

Figure 71.  Print Menu

•	 To print the report in its currently displayed configuration (format), select Print. The 
report prints on your printer. 

•	 To verify or change the page setup options (margins, paper size, etc.), click Page Setup. 
Review or make changes to the Page Setup form. 

•	 To preview the report before printing it, click Print Preview. 
•	 To print one copy of each of your favorites on the default printer, click Print Favorite 

Reports for..., then select the device type you want to print the reports for. 
•	 To save the open report in the Adobe Acrobat (PDF) file format, click Save as PDF file. 

Select this option if the E-Mail Report to option (below) does not automatically create a 
*.pdf file. Or select this option if you have a printing problem and want to print from 
Adobe Acrobat. (The Adobe Acrobat Reader program must be installed on your 
computer. Go to www.Adobe.com for instructions on downloading this program.)

•	 To e-mail the report as an attachment, click E-Mail Report to. The report is attached to 
the e-mail message as a *.pdf file. (You do not have to Save as PDF file first.) 

Note:	 The E-Mail Report to option is designed to access your e-mail account and open a new 
e-mail message screen. If your e-mail account is not detected automatically, you will 
need to e‑mail the report manually. To do so:

•	 With the desired report open, select the Save as PDF file option from the Print drop-
down box on the Reports toolbar. Then manually attach the *.pdf file to an e-mail.
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5.3      Personalizing Report Settings

Reports can be personalized to your preferences by making choices for Report Options on the 
Profile for: screen and by activating data filters and display features on the Report Configuration 
screen.

5.3.1   Report Options (User or HCP Profile)

On the Profile for: page, click the Options tab. 

Figure 72.  User Profile Screen with Options Tab Active

The Report Options are on the right.  The Default Report is the report you want to display 

when you select  on the Home page. 

•	 Select your preferred default report in the Default Report Type list. 
•	 Select your preferred default date range interval for the default report from the Default 

Report Date Range list.
•	 Select Print Using Adobe Acrobat to enable the PDF printer option. Use this option if a 

report does not print correctly on your printer.  
•	 Select whether to attach a Statistics Summary whenever a report is printed. 
•	 Select the number of characters at the end of the User (or Patient) ID to display on report 

headers.  Select 0 (zero) if the ID is not to be displayed on report headers.

Report 
Options
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•	 To select your Favorite Reports, check any report or set of reports you prefer to print 
when you select Print Favorite Reports After Device Upload (using Read Device) or 
when you use Quick Print (see Section 4.1.5: Quick Print).  You may select a different set of 
Favorite Reports for each type of device installed by selecting the appropriate device 
tab (if applicable). For each report, complete the Date Range. Selected date ranges may 
be different for different reports. 

Note:	 A separate Statistics Summary does not automatically print with your Favorite 
Reports even if  Include Statistics Summary With Each Report Printout is 
selected.

Note:	   The Statistics Summary is not attached to reports you email. It also does not display 
when you select Print Preview even though it will be printed with the report. 

5.3.2   Data Filters

Data filters are tools for selecting the types of data you want to include in a report. You select 
the data filters you want by clicking the Report Configuration icon  on the Reports toolbar 
and choosing items from the Event Types, Time Periods, and Week Days sections on the Data 
Filter tab. Click Apply to save any changes. Click OK to save changes and return to the report. 

Figure 73.  Report Configuration: Data Filter Tab

Data filters and display features (see Section 5.3.3) apply to all reports except the HCP Group 
Analysis Report. Changing data filter or display settings in any report changes them for all 
other open reports. Not all filters are configurable in all reports. 
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Event Types

There are two types of Glucose events: Glucose (BG) refers to results from a blood glucose 
meter. Glucose (CM) refers to results from a continuous glucose monitoring system.

Time Periods - If you de-select the Pre-Breakfast, Pre-Lunch, or Pre-Dinner options on the 
Data Filter tab, the carbohydrates for the corresponding meal (breakfast, lunch, or dinner), if 
entered manually or uploaded into the FreeStyle CoPilot system, will not be displayed on the 
reports that would ordinarily show this information. 

Week Days - Week Days filters do not apply to the Daily Combination View Report.

Several data filters can be applied together. For example, you could un-check Exercise events 
in the Event Types filter and check only Tuesday and Friday in the Week Days filter.

5.3.3   Display Features 

Some display features are configured on the Miscellaneous tab of the Report Configuration 
screen. 

Figure 74.  Report Configuration: Miscellaneous Tab
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GENERAL ITEMS 
Display Time Periods Select to display time periods on the report.

Show Hypo/Hyper Deselect to display glucose readings in three target ranges: High, Within, 
and Low. 
Select to display glucose readings in five target ranges: Very High, High, 
Within, Low, and Very Low.
Note: If you select to display glucose data in three target ranges (the Show 
Hypo/Hyper box is not checked), Very High readings display as High 
readings (purple) and Very Low readings display as Low readings (yellow).

Show Glucose Targets Select to display glucose readings data in their unique color or pattern (black 
and white display).

Show Hidden Data Select to view all entries in the Diary List, including those you marked Hide. 

Show Text on Graphs in Daily 
Combination Report

Select to view numerical values of glucose readings.

Show Legend Select to display the legend in all applicable reports. Displaying the legend 
will help you understand the report. 

Color Select to display glucose target ranges in their unique colors. See Section 
3.1.4: Glucose Targets Tabs for information about glucose target ranges. 
Deselect to display glucose target ranges in their distinctive patterns for 
black-and-white printing.

Devices This list includes all installed meters and other supported devices. See 
Appendix C: Supported Devices and Databases.  
If you have installed only one device, you cannot deselect the device (to filter 
out the data.) If you have two or more devices installed, one device must 
always be selected. 

Figure 75.  Black-and-White Display Patterns (Screen Detail)
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5.4      Glucose Target Modes

The following is a table of the reports that use glucose targets, and the modes they use: 

Report Home User Version 
Glucose Target Mode

HCP Version 
Glucose Target Mode

Diary List User’s choice HCP’s choice

Glucose Modal Day User’s choice HCP’s choice

Glucose Line Standard Mode Standard Mode

Glucose Average Standard Mode Standard Mode

Glucose Histogram Standard Mode Standard Mode

Glucose Pie Chart User’s choice HCP’s choice

Logbook User’s choice HCP’s choice

Lab and Exam Record Not applicable Not applicable

Statistics User’s choice HCP’s choice

Daily Combination View User’s choice HCP’s choice

Weekly Pump View Standard Mode Standard Mode

HCP Group Analysis Not applicable Standard Mode

5.5      Definition of a Day

Depending on the report, a day (24 hours) is calculated from midnight to midnight or pre-
breakfast to pre-breakfast. The various reports define a day as follows:

Report Definition of a Day
Diary List Midnight to Midnight

Glucose Modal Day Pre-breakfast to Pre-breakfast

Glucose Line Midnight to Midnight

Glucose Average Pre-breakfast to Pre-breakfast

Glucose Histogram Midnight to Midnight

Glucose Pie Chart Pre-breakfast to Pre-breakfast

Logbook Pre-breakfast to Pre-breakfast

Lab and Exam Record Midnight to Midnight

Statistics Pre-breakfast to Pre-breakfast

Daily Combination View Midnight to Midnight

Weekly Pump View Midnight to Midnight

HCP Group Analysis Midnight to Midnight
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5.6      Descriptions of Reports

Carefully review the earlier sections in this section before reading these descriptions. The earlier 
material provides important overall guidelines for viewing, navigating, and personalizing reports. 

WARNING:
•	 Have your healthcare professional review and confirm your entries before using this data. 

Serious effects on your health could result from relying on or using incorrect entries.
CAUTION:	 If any event data is Hidden, a comment will appear at the top of the report 

indicating the number of Hidden events. Hidden data will not be displayed or 
included in the calculations for that report. 

5.6.1   Two Week Glucose Summary with Logbook

The Two Week Glucose Summary with Logbook provides a consolidated view of the following 
individual reports in a single summary report for a specified 2-week date range:

•	 Glucose Modal Day (see Section 5.6.4)
•	 Glucose Pie (see Section 5.6.8)
•	 Statistics (see Section 5.6.11)
•	 Logbook (see Section 5.6.9)
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•	 To select the 2-week date range for the data you want to view, use the date field on the 
right to select the last date you want to see.

•	 The number of pages that will print is dependent on the number of glucose entries in the 
Logbook within the specified 2-week date range.

Note:	 If there are a large number of glucose entries within the specified 2-week date range 
(e.g. when uploading data from a continuous glucose monitoring device), it is highly 
recommended that the Two Week Glucose Summary report be selected instead which 
does not include the Logbook in order to minimize the number of printed pages.

To maximize legibility in this consolidated summary report format, there are minor formatting 
adjustments in addition to the following differences from the individual reports:

•	 The Statistics section is limited to the following statistics:  # Readings, Highest, Lowest, 
Average, Standard Deviation, and Within %.

•	 The Logbook section is limited to displaying glucose values only.  The insulin and 
carbohydrate columns do not appear.

•	 The glucose values in the Logbook section that are not within range (i.e. Low or High 
glucose values) are in bold italic instead of being in distinctive colors.

•	 The timestamps have been removed for the individual glucose values in the Logbook 
section.  Instead, the user-specified Time Periods (pre-meal and post-meal) appear 
under the column headings for each meal.
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5.6.2   Two Week Glucose Summary

The Two Week Glucose Summary, similar to the Two Week Glucose Summary with Logbook 
above, provides a consolidated view of the following individual reports in a single summary 
report for a specified 2-week date range:

•	 Glucose Modal Day (see Section 5.6.4)
•	 Glucose Pie (see Section 5.6.8)
•	 Statistics (see Section 5.6.11)

If there are a large number of glucose entries within the specified 2-week date range (e.g. when 
uploading data from a continuous glucose monitoring device), it is highly recommended that 
the Two Week Glucose Summary report be selected which does not include the Logbook in 
order to minimize the number of printed pages.
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5.6.3   Diary List

The Diary List is a table of all data entries made over the specified date range. Each row 
corresponds to one event.

Figure 76.  Diary List

•    A day (24 hours) is defined as midnight to midnight.
•    The glucose target mode is your choice.
•    �Columns are for data categories. The Value column displays the value in units 

appropriate to the event type. For Glucose Reading events, the Value cell is shaded with 
the unique color for the glucose target range. 

•	 To open the original Data Entry screen for a specific event, double-click any cell in the 
row. 

•	 Data that was entered manually can be edited. Some fields in uploads from devices can 
be edited.

WARNING:  
•	 ��Some Deltec Cozmo Insulin Pump events such as disconnect, reconnect and cancelled 

boluses are not included.

Note:	 When uploading data from a device, or when importing data from Precision Link system 
(version 2.5 or higher), glucose readings greater than 500 are displayed as “501”, and 
readings less than 20 are displayed as “19”. 
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Hide/Un-Hide Events

By default, the Diary List contains a Hidden column (far-left). Entries you have chosen to hide 
will display  in the Hidden column.

Figure 77.  Diary List with Hidden Column Displayed 

•	 To Hide an event, select the row, and right-click. Click Hide Data on the context menu. 
When prompted to confirm, click Yes to hide the data. 

Figure 78.  Reports: Context Menu

•	 To Un-Hide an event, click any cell in a row that displays  in the Hidden column. Next, 
right-click and select Un-Hide Data from the context menu. The event is no longer 
hidden.

•	 The Diary List displays Hidden data and the Hidden column by default. To not display 
Hidden data on the Diary List: 

•	 Click  on the Reports toolbar. Click the Miscellaneous tab and un-check the box to 
Show Hidden Data. Click OK. The Diary List will no longer display Hidden data and the 
Hidden column. 

Hidden 
column
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Figure 79.  Diary List: Hidden Column and Hidden Data Not Displayed

•	 Only the Diary List can display Hidden data. In all other reports, Hidden events are not 
displayed or included in the calculations even if you checked the box to Show Hidden 
Data on the Miscellaneous tab.

•	 The Hidden column must be displayed in order to Un-Hide events. It is recommended 
to always display Hidden data.

Columns

You can customize the columns in the Diary List by changing the order of events in a column, 
adding and removing columns, and resizing columns. These changes are saved when you close 
the Diary List or exit the FreeStyle CoPilot system.

Change Order of Events

To change the order of the events in the Diary List, click any of the following column heads:

Hidden Hidden entries display in descending order (latest date at the top). 
Click to display all hidden entries at the top. Click again to display 
all hidden entries at the bottom.

Type Events are grouped by Event Type. Click to reverse the order.

Date Events display in ascending order (earliest date at the top) or 
descending order (latest date at the top). Click to reverse the order.

Time The events display in chronological order. Click to group entries by 
time of day.

Time Period Time periods are arranged in chronological order. Click to list the 
time periods in alphabetical order.

Value Click to display the values in alphanumeric order. Click again to 
reverse the alphanumeric order.

Hidden column and 
hidden data are not  
displayed
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Description Events are displayed in ascending alphabetical order. Click to 
reverse the order.

Other Info Click to reverse the order.
Comment Events with Comments display in ascending alphabetical order. 

Events with no comments display first. Click to reverse the order.

Remove/Add Columns

•	 To remove a column from the report, drag-and-drop the column head cell off the table.
•	 To add a column to the report, right-click anywhere on the table to call up the context 

menu. Select Customize Columns. The Customization list displays. From the list, select 
the column head you want to add. Drag-and-drop it to the preferred position in the 
column-head row. Two green arrows display to help you position the column. 

Figure 80.  Customization List

Move/Resize Columns

•	 To move columns left or right in the table, drag-and-drop the column-head cell to the 
preferred position in the column head row. 

•      To adjust the width of any column, use the sizing tool that becomes active when you 
hover your pointer over the right margin of the column-head cell. 
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5.6.4   Glucose Modal Day Report

The Glucose Modal Day Report shows the daily pattern of glucose levels over the specified 
date range. A line linking the readings for a specific date can be displayed or hidden.

Figure 81.  Glucose Modal Day Report

•	 The horizontal axis is a 24-hour timeline. All readings for all dates display on the same 
timeline. The vertical axis plots the glucose level.

•	 A day (24 hours) is defined as pre-breakfast to pre-breakfast.
•	 The glucose target mode is your choice. 
•	 Each data symbol represents one glucose reading. For the date, time, and value of the 

reading, hover the pointer over the data symbol. 
•	 HI/LO indicates a reading outside the working range of the meter.
•	 A list of all days in the date range displays to the right of the graph. 
•	 To link all the readings for a single day with a line, click the date of interest in the list of all 

days in the date range. All the data symbols for that date change color and a line is drawn 
linking them. Click any data symbol or in the line to cancel the line.

•	 To zoom in on (magnify) an area of the graph, place the mouse in the upper left of the 
graph, press and hold the left mouse button, and drag to the lower right corner of the 
graph. Repeat this action to further magnify the area of interest. To return the graph to its 
original state, place the mouse in the lower right of the graph, press and hold the left 
mouse button, and drag to the upper left corner.

•	 To go to the Glucose Reading entry in the Diary List, double-click the data symbol. 

List of all 
days in 
date range
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IMPORTANT:	 Please customize your Time Periods before entering data into the FreeStyle 
CoPilot system. If the Display Time Periods setting is turned on for the 
Glucose Modal Day Report, changing the Time Periods after data has been 
entered will result in the data appearing based on the Time Periods. This 
may result in data not corresponding to the event times.

CAUTION:	 If the user reconfigures the Glucose Modal Day report by turning Display Time 
Periods OFF, the Glucose Modal Day report will go back to plotting the data 
point based on the user-configured time period and remove the Time Period 
labels across the top of the graph. This can result in a data point for any glucose 
reading, where a user manually assigned the time period, being displayed in a 
different location on the Glucose Modal Day graph. When the Display Time 
Periods is ON, the glucose reading that has a manually assigned time period will 
be displayed on the graph in the middle of the time period assigned.
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5.6.5   Glucose Line Report

The Glucose Line Report is useful for seeing trends in glucose levels. It plots each glucose 
reading over the specified date range. 

Figure 82.  Glucose Line Report (Show Line Is Activated) 

•	 The horizontal axis is a timeline of the entire date range. The vertical axis plots the 
glucose level.

•	 A day (24 hours) is defined as midnight to midnight.
•	 The glucose target mode is Standard. 
•	 Each data symbol represents one reading; a solid line connecting them can be displayed 

or hidden. To hide the line, point to any data symbol, and right-click. Click Show/Hide 
Line on the context menu.

•	 For the date, time, and value of the glucose reading, hover the pointer over the data 
symbol. 

•	 To zoom in on (magnify) an area of the graph, place the mouse in the upper left of the 
graph, press and hold the left mouse button, and drag to the lower right corner of the 
graph. Repeat this action to further magnify the area of interest. To return the graph to its 
original state, place the mouse in the lower right of the graph, press and hold the left 
mouse button, and drag to the upper left corner.

•	 To go to the event data in the Diary List, double-click the data symbol. 
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5.6.6   Glucose Average Report

The Glucose Average Report may help identify times of the day that may need more testing or 
improved control. The report separates all glucose readings over the specified date range into 
pre-meal (yellow bars) and post-meal (blue bars) groupings and averages the values for each 
group. 

For convenience, there are two graphs. One shows pre-meal and post-meal glucose averages 
over the date range by meal. The other shows overall pre-meal and post-meal averages by day 
over the date range.

Figure 83.  Glucose Average Report: By Meal 

•	 The asterisk (*) next to the title indicates that the report does not include sleep or 
bedtime data.

•	 The glucose target mode is Standard. 
•	 The horizontal axis is a timeline showing the time periods (pre-meal and post-meal) and 

the average for all meals. The vertical axis plots the glucose level.
•	 Each bar shows the average value of all glucose readings over the date range for the 

specific time period (for example, the average value of all pre-breakfast readings). 
•	 A day (24 hours) is defined as pre-breakfast to pre-breakfast. 
•	 Double-click any bar to call up the Diary List entries for these events. 
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Figure 84.  Glucose Average Report: By Day 
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5.6.7   Glucose Histogram Report

The Glucose Histogram Report separates all glucose readings over the specified date range 
into the default target ranges and displays the data as a histogram (bar chart) with its bar 
height proportional to the number of readings in each glucose target range. 

Figure 85.  Glucose Histogram Report

•	 The glucose target mode is Standard. 
•	 The horizontal axis shows the default glucose target ranges (not the user-defined 

glucose target ranges). The vertical axis plots the Number of Readings.
•	 A day (24 hours) is defined as midnight to midnight. 
•	 The color of the bar corresponds to the unique color for the glucose target range. The 

height of the bar is proportional to the number of readings in that range; that is, the bar 
for a range in which there are 20 readings is twice as high as the bar for a range with 10 
readings. The percentage of readings in the range is shown at the top of the bar. 

•	 Double-click the bar to call up the Diary List entries that make up that bar. 
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5.6.8   Glucose Pie Chart 

The Glucose Pie Chart separates glucose readings over the date range into the default glucose 
target ranges and averages the values within each range. These averages are displayed in a 
series of pie charts. Each segment (wedge) displays in the unique color of its glucose target 
range. 

Figure 86.  Glucose Pie Chart Report: Total Readings Pie Chart

Figure 87.  Glucose Pie Chart Report: Summary Pie Charts

•	 A maximum of 10 individual pie charts (2 rows of 5) and 1 total pie chart summarizing 
the glucose readings for all configured time periods over the date range are displayed.

•	 A day (24 hours) is defined as pre-breakfast to pre-breakfast on Total Readings pie chart.
•	 The glucose target mode is your choice. 
•	 Double-click a wedge on any of the pie charts to call up the Diary List entries that make 

up that wedge. 
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5.6.9   Logbook Report

The Logbook Report is a table of glucose, carbohydrate, and insulin values associated with 
each time period over the specified date range. 

WARNING:  
•	 �Some Deltec Cozmo Insulin Pump events such as disconnect, reconnect and cancelled 

boluses are not included.

CAUTION: 	 If any event data is Hidden, a comment will appear at the top of the report 
indicating the number of Hidden events. Hidden data will not be displayed or 
included in the calculations for this report.

Figure 88.  Logbook Report 

•	 Insulin, carbohydrate, and pre-meal, post-meal, bedtime, and sleep glucose reading 
values are displayed in columns under each time period (Breakfast, Lunch, Dinner, Bed 
& Sleep) for each day over the date range. 

•	 A day (24 hours) is defined as pre-breakfast to pre-breakfast.
•	 The glucose target mode is your choice.
•	 To call up the entry in the Diary List, double-click any cell in the row. 
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5.6.10   Lab and Exam Record Report 

The Lab and Exam Record Report is a table of data from all Medical Exam and Lab Test Result 
data entry screens over the specified date range.

CAUTION: 	 If any event data is Hidden, a comment will appear at the top of the report 
indicating the number of Hidden events. Hidden data will not be displayed or 
included in the calculations for this report.

Figure 89.  Lab and Exam Record Report

•	 The screen shows a table of lab test data on the top and the exam data below. Each event 
is shown in one row. 

•	 A day (24 hours) is defined as midnight to midnight.
•	 Double-click any cell in a row to go to the Diary List entry for the event.
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5.6.11   Statistics Report

The Statistics Report provides an overview of glucose, carbohydrate, and insulin data 
(including insulin pump data) over the date range and displays it in a series of tables. You can 
attach the Statistics Report to any other report by enabling from the User Profile/Option tab.

Figure 90.  Statistics Report: Glucose Statistics

•      A day (24 hours) is defined as pre-breakfast to pre-breakfast.
•      The glucose target mode is your choice.
•      Double-click any cell to see the entries from the Diary List that are included in the data 

set for a particular statistical calculation.
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Glucose Statistics Table
The Glucose Statistics Table shows data regarding the number of readings per day, the values 
of the highest and lowest readings in each time period, and the results of some automatic 
calculations (averages and standard deviation) within and across time periods.

CAUTION: 	 If any event data is Hidden, a comment will appear at the top of the report 
indicating the number of Hidden events. Hidden data will not be displayed or 
included in the calculations for this report. 

# Readings By Time Period: Reports the number of readings recorded during the 
Time Period specified for each day of the selected Date Range. 
Total/Summary: Reports the number of readings recorded during the 
selected Date Range.

# Days with 
Readings

By Time Period: Reports the number of days within the selected Date 
Range where one or more readings are recorded during the specified 
Time Period. 
Total/Summary: Reports the number of days within the selected Date 
Range where one or more readings are recorded.

Avg Readings/
Day

By Time Period: Reports the number of readings recorded during the 
Time Period specified for each day of the selected Date Range divided 
by the number of days in the selected Date Range regardless of 
whether a glucose reading was recorded or not. 
Total/Summary: Reports the number of readings recorded during the 
selected Date Range divided by the number of days in the selected 
Date Range regardless of whether a glucose reading was recorded or 
not.

Highest By Time Period: Reports the highest reading recorded during the 
Time Period specified within the selected Date Range. 
Total/Summary: Reports the highest reading recorded during the 
selected Date Range.

Lowest By Time Period: Reports the lowest reading recorded during the Time 
Period specified within the selected Date Range. 
Total/Summary: Reports the lowest reading recorded during the 
selected Date Range.

Average By Time Period: Reports the sum of the readings recorded during the 
selected Date Range that fall within the specified Time Period divided 
by the number of readings recorded during the selected Date Range 
that fall within the specified Time Period. 
Total/Summary: Reports the sum of the readings recorded during the 
selected Date Range divided by the number of readings recorded 
during the selected Date Range.
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Standard 
Deviation

By Time Period: Reports the standard deviation* of the readings 
recorded during the Time Period specified within the selected Date 
Range. 
Total/Summary: Reports the standard deviation* of the readings 
recorded during the selected Date Range. 
Note: N/A is displayed where fewer than three readings are recorded.

*Standard deviation is a statistical calculation that tells how close a set 
of values is clustered around the average of those values. It is a 
measure of dispersal or variation of the patient’s average glucose level. 
For example, a small number (less than half the average) indicate that 
most of the glucose readings during the day are close to the average 
value and that the patient is maintaining glucose levels near that 
value. A large number (more than half the average) indicates that 
many glucose levels during the day vary considerably from the 
average and that the patient is not maintaining glucose levels near the 
average value.

Above % By Time Period: Reports the number of readings recorded above the 
patient’s defined normal glucose limits during the Time Period 
specified within the selected Date Range divided by the total number 
of readings recorded during the Time Period specified within the 
selected Date Range** and multiplied by 100. 
Total/Summary: Reports the total number of readings recorded 
above the patient’s defined normal glucose limits during the selected 
Date Range divided by the total number of readings recorded during 
the selected Date Range** and multiplied by 100.

Within % By Time Period: Reports the number of readings recorded within the 
patient’s defined normal glucose limits during the Time Period 
specified within the selected Date Range divided by the total number 
of readings recorded during the Time Period specified within the 
selected Date Range and multiplied by 100. 
Total/Summary: Reports the total number of readings recorded 
within the patient’s defined normal glucose limits during the selected 
Date Range divided by the total number of readings recorded during 
the selected Date Range and multiplied by 100.

Below % By Time Period: Reports the number of readings recorded below the 
patient’s defined normal glucose limits during the Time Period 
specified within the selected Date Range divided by the total number 
of readings recorded during the Time Period specified within the 
selected Date Range** and multiplied by 100. 
Total/Summary: Reports the total number of readings recorded 
below the patient’s defined normal glucose limits during the selected 
Date Range divided by the total number of readings recorded during 
the selected Date Range** and multiplied by 100.

** Available when three target zones are being reported: Show Hypo/
Hyper not selected.
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Very High % By Time Period: Reports the number of readings recorded as 
hyperglycemic events during the Time Period specified within the 
selected Date Range divided by the total number of readings recorded 
during the Time Period specified within the selected Date Range*** 
and multiplied by 100. 
Total/Summary: Reports the total number of readings recorded as 
hyperglycemic events during the selected Date Range divided by the 
total number of readings recorded during the selected Date Range*** 
and multiplied by 100.

High % By Time Period: Reports the number of readings recorded above the 
patient’s defined normal glucose limits and below the limits of a 
hyperglycemic event during the Time Period specified within the 
selected Date Range divided by the total number of readings recorded 
during the Time Period specified within the selected Date Range*** 
and multiplied by 100. 
Total/Summary: Reports the total number of readings recorded 
above the patient’s defined normal glucose limits and below the limits 
of a hyper event during the selected Date Range divided by the total 
number of readings recorded during the selected Date Range*** and 
multiplied by 100.

Low % By Time Period: Reports the number of readings recorded below the 
patient’s defined normal glucose limits and above the limits of a hypo 
event during the Time Period specified within the selected Date Range 
divided by the total number of readings recorded during the Time 
Period specified within the selected Date Range*** and multiplied by 
100. 
Total/Summary: Reports the total number of readings recorded 
below the patient’s defined normal glucose limits and above the limits 
of a hypo event during the selected Date Range divided by the total 
number of readings recorded during the selected Date Range*** and 
multiplied by 100.

Very Low % By Time Period: Reports the number of readings recorded as hypo 
events during the Time Period specified within the selected Date 
Range divided by the total number of readings recorded during the 
Time Period specified within the selected Date Range*** and 
multiplied by 100. 
Total/Summary: Reports the total number of readings recorded as 
hypo events during the selected Date Range divided by the total 
number of readings recorded during the selected Date Range*** and 
multiplied by 100.

*** Available when five target zones are being reported: Show Hypo/
Hyper selected.
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Insulin Statistics

The Insulin Statistics table shows average insulin dosages over the date range (calculated 
from insulin data). 

Figure 91.  Statistics Report: Insulin Statistics Tables

Avg/Day 
(Insulin Name)

By Time Period: Reports the sum of the units of insulin delivered 
during the Time Period specified for the selected Date Range divided 
by the number of days in the selected Date Range where that 
particular type of Insulin was recorded during that Time Period. 
Total/Summary: Reports the sum of the units of Insulin delivered 
during the selected Date Range divided by the number of days in the 
selected Date Range where that particular type of Insulin was 
recorded. 
Note: Separate entries exist for each type of Insulin recorded.

Avg/Day Total 
Insulin

By Time Period: Reports the sum of the units of all insulin delivered 
during the Time Period specified for the selected Date Range divided 
by the number of days in the selected Date Range where any type of 
Insulin was recorded during that Time Period. 
Total/Summary: Reports the sum of the units of all Insulin delivered 
during the selected Date Range divided by the number of days in the 
selected Date Range where any type of Insulin was recorded.

Note:	   These entries are calculated using all types of insulin recorded.
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Pump Statistics Table

If your insulin is administered by pump, the table will say Pump Statistics (instead of Insulin 
Statistics) and display the following information:

Figure 92.  Statistics Report: Pump and Carbohydrates Statistics Tables

Avg/Day Meal 
Bolus

By Time Period: Reports the sum of all Meal Bolus Insulin recorded 
during the specified Time Period for the selected Date Range divided 
by the number of days in the selected Date Range where Meal Bolus 
Insulin entries were recorded during that Time Period. 
Total/Summary: Reports the sum of all Meal Bolus Insulin recorded 
during the selected Date Range divided by the number of days in the 
selected Date Range where Meal Bolus Insulin entries were recorded.

Note:  Meal Bolus is defined as the sum of all insulin entries (from 
pump uploads and manual entries) of the following injection types: 
Injection, Bolus, Meal Bolus, Combination Bolus, Dual Wave Bolus, 
and Square Wave Bolus. 

Avg/Day 
Correction 
Bolus

By Time Period: Reports the sum of all Correction Bolus Insulin 
recorded during the specified Time Period for the selected Date Range 
divided by the number of days in the selected Date Range where 
Correction Bolus Insulin entries were recorded during that Time 
Period. 
Total/Summary: Reports the sum of all Correction Bolus Insulin 
recorded during the selected Date Range divided by the number of 
days in the selected Date Range where Correction Bolus Insulin entries 
were recorded.

Avg/Day Total 
Bolus

By Time Period: Reports the sum of all Meal and Correction Bolus 
Insulin entries recorded during the specified Time Period for the 
selected Date Range divided by the number of days in the selected 
Date Range where Meal and Correction Bolus Insulin entries were 
recorded during that Time Period. 
Total/Summary: Reports the sum of all Meal and Correction Bolus 
Insulin entries recorded during the selected Date Range divided by the 
number of days in the selected Date Range where Meal and Correction 
Bolus Insulin entries were recorded.
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Avg/Day Basal By Time Period: Reports the sum of the Basal Insulin delivered during 
the Time Period specified for the selected Date Range divided by the 
number of days in the selected Date Range where Basal Insulin was 
recorded for that Time Period. 
Total/Summary: Reports the sum of the Basal Insulin delivered during 
the selected Date Range divided by the number of days in the selected 
Date Range where Basal Insulin was recorded.

Avg/Day Total 
Insulin

By Time Period: Reports the sum of the Total Bolus and Basal Insulin 
doses delivered during the Time Period specified for the selected Date 
Range divided by the number of days in the selected Date Range 
where Insulin entries were recorded for that Time Period. 
Total/Summary: Reports the sum of the Total Bolus and Basal Insulin 
doses delivered during the selected Date Range divided by the 
number of days in the selected Date Range where Insulin entries were 
recorded.

Note:	 Days where no Insulin entries were recorded during the specified Time 
Period will not be included in the By Time Period calculation. Days where 
no Insulin entries were recorded will not be included in the Total 
calculation.

WARNING:  
•	 Imports from the CoZmanager System (pump) include data only from full days (24 

hours), not partial days. This is so that CoZmanager can provide daily totals.

WARNING:  
•	 �Some Deltec Cozmo Insulin Pump events such as disconnect, reconnect and cancelled 

boluses are not included.

CAUTION:	 Total Insulin statistics based on data from the CoZmanager System (pump) may 
differ from the sum of the individual insulin fields that make up the total. This is 
because CoZmanager may record the amount of a cancelled bolus. The Total 
Insulin statistic on any FreeStyle CoPilot system report displays only the insulin 
delivered, not the cancelled bolus.

CAUTION:	 Total Insulin statistics may appear to vary from report to report. This is usually 
due to how the report defines a day. 
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Carbohydrate Statistics Table
The Carbohydrates Statistics table shows average carbohydrates over the date range 
(calculated from carbohydrates data).

Avg/Day Carbs By Time Period: Reports the sum of the meal Carbohydrate intake for 
the Time Period specified during the selected Date Range divided by 
the number of days within the selected Date Range where meal 
Carbohydrate entries were recorded during the Time Period specified. 
Total/Summary: Reports the sum of the meal Carbohydrate intake 
during the selected Date Range divided by the number of days within 
the selected Date Range where meal Carbohydrate entries were 
recorded.

Note:	 Days where no Meal entries were recorded during the specified Time Period will not be 
included in the By Time Period average. Days where no Meal entries were recorded will 
not be included in the Total average.
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5.6.12   Daily Combination View Report

The Daily Combination View Report summarizes glucose, carbohydrate, and insulin data 
(including pump data) for a single day and displays it in both graphic and table formats. 

•      To select the day for the data you want to see, use the date field on the right. 

Figure 93.  Date Field for Selecting Date 

•      A day (24 hours) is defined as midnight to midnight. 
•      The glucose target mode is your choice. 

Note:	   Week Days filters do not apply to the Daily Combination View Report. See Section 
5.3.2: Data Filters.

CAUTION:	 If any event data is Hidden, a comment will appear at the top of the report 
indicating the number of Hidden events. Hidden data will not be displayed or 
included in the calculations for this report.

Figure 94.  Daily Combination View: Glucose Line and Carbohydrates Graphs

Select day you want  
to view in this date field.
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Glucose Line Graph 

The Glucose Line graph plots glucose readings by hour of day. 

•	 The horizontal axis is a 24-hour timeline. The vertical axis plots the glucose level.
•	 Each data symbol represents one reading. Hover the cursor over the data symbol to see 

the glucose value, date, and time of that reading.
•	 Double-click a data symbol to view this entry in the Diary List.
•	 To display or hide the solid line connecting the data symbols, right-click a data symbol, 

and select Toggle Glucose Line from the context menu.

Carbohydrates Graph

The Carbohydrates Graph plots carbohydrate events by hour of day. 

•	 The carbohydrate data symbol  represents one carbohydrate event. The size of the 
circle is proportional to the carbohydrate value. Its position along the horizontal axis 
corresponds to the time (hour) of the meal. 

•    Double-Click  to view this entry in the Diary List.

Figure 95.  Daily Combination View Report: Insulin Summary and Data Table
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Insulin Summary 

The Insulin Summary graph plots insulin events by hour of day. 

•    The horizontal axis is a 24-hour timeline. The vertical axis is units of insulin.
•    Basal insulin data (light green shaded area) can be imported into the FreeStyle CoPilot 

system only from CoZmanager software. 
•    Each dark green bar represents one meal bolus insulin event. Its position along the 

horizontal axis corresponds to the time (hour) of the insulin event. Its height correlates 
with dosage. Double-click to view this entry in the Diary List. 

•    Each red bar represents one correction bolus insulin event. Its position along the 
horizontal axis corresponds to the time (hour) of the insulin event. Its height correlates 
with dosage. Double-click to view this entry in the Diary List. 

•    If pump data has not been imported into the FreeStyle CoPilot system from CoZmanager 
software, manually entered meal bolus and correction bolus will not appear separately. 
Instead, a green bar will indicate all manually entered bolus events. Its position along the 
horizontal axis corresponds to the time (hour) of the insulin event. Its height correlates 
with dosage. Double-click to view this entry in the Diary List.

Data Table

The Data Table tracks glucose, carbohydrates, and insulin values hourly.

•    Each column represents 1 hour. 
•    Each event type is one row. 
•    Each event is one cell. The value associated with the event displays in the cell. Double-

click the cell to view this event in the Diary List.

Note:	   The symbol “...” indicates that the full value does not fit in the space provided. To call 
up the full entry in the Diary List, double-click “...”.

WARNING:  
•	 Imports from the CoZmanager System (pump) include data only from full days (24 

hours), not partial days. This is so that CoZmanager can provide daily totals.

WARNING:  
•	 �Some Deltec Cozmo Insulin Pump events such as disconnect, reconnect and cancelled 

boluses are not included.

CAUTION:	 Total Insulin statistics based on data from the CoZmanager System (pump) may 
differ from the sum of the individual insulin fields that make up the total. This is 
because CoZmanager may record the amount of a cancelled bolus. The Total 
Insulin statistic on any FreeStyle CoPilot system report displays only the insulin 
delivered, not the cancelled bolus.

CAUTION:	 Total Insulin statistics may appear to vary from report to report. This is usually 
due to how the report defines a day.
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5.6.13   Weekly Pump View Report

The Weekly Pump View Report shows the components of insulin doses for each day in a 
seven-day period in bar graph and pie chart formats.

CAUTION:	 If any event data is Hidden, a comment will appear at the top of the report 
indicating the number of Hidden events. Hidden data will not be displayed or 
included in the calculations for this report.

To select the week (7 days) for the data you want to view:

•	 Using the date field on the right, select the last date in the week you want to see 
(3/17/07, for example).

Figure 96.  Date Field for Selecting Date 

•	 A day (24 hours) is defined as midnight to midnight.
•	 The glucose target mode is Standard.

Figure 97.  Weekly Pump View Report: Bar Graph

Set to last date in 
week.
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Figure 98.  Weekly Pump View Report: Pie Charts and Glucose Statistics Table

•	 Double-click any cell to view this entry in the Diary List.
•	 Basal insulin data (light green shaded area) is imported into the FreeStyle CoPilot system 

only from CoZmanager System software. 
•	 A Glucose Statistics table summarizes the glucose readings for the week displayed. 

WARNING:
•	 Imports from the CoZmanager System (pump) include data only from full days (24 

hours), not partial days. This is so that CoZmanager can provide daily totals.

CAUTION:	 Total Insulin statistics based on data from the CoZmanager System (pump) may 
differ from the sum of the individual insulin fields that make up the total. This is 
because CoZmanager may record the amount of a cancelled bolus. The Total 
Insulin statistic on any FreeStyle CoPilot system report displays only the insulin 
delivered, not the cancelled bolus.

CAUTION:	 Total Insulin statistics may appear to vary from report to report. This is usually 
due to how the report defines a day.
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5.6.14   HCP Group Analysis Report

The HCP Group Analysis Report is available to HCP Users only. This report is a user-configurable 
view of all the FreeStyle CoPilot system data for all patients of the HCP. The HCP can display data 
for any patient he/she manages. This includes all device data uploaded at the clinic during a 
patient visit, all data entered manually at the clinic, and all data imported into the HCP’s 
database through information sharing through FreeStyle CoPilot system Host. This report 
facilitates viewing and comparing of data for all patients of the HCP or clinic. 

Figure 99.  HCP Group Analysis Report

•	 By default, the report displays with column heads for Patient ID, Last Name, First Name, 
and for a number of event-related data fields. 

•	 Data for each patient displays in one row. Each glucose value displays in a cell shaded the 
unique color of its target range. 

•	 The glucose target mode is Standard.
•	 A day (24 hours) is defined as midnight to midnight.

Columns

You can customize the columns in the HCP Group Analysis Report by changing the order of 
events in a column, adding and removing columns, and resizing columns. 
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Change Order of Events

•	 To reverse the order of items in any column, click the column heading, and click the little 
arrow that appears to the right of the heading. Do the same to change the order back to 
its original sequence.

Add/Remove Columns

•	 To remove a column from the report, drag-and-drop the column head cell off the table.
•	 To add a column to the report, right-click anywhere on the table to call up a context 

menu. Click Customize Columns. 

 

Figure 100.  Context Menu

The Customization list displays. From the list, select the column head you want to add. Next, 
drag-and-drop it to the preferred position in the column-head row. Two green arrows display to 
help you position the column. 

Figure 101.  Customization List

Move/Resize Columns

•	 To move columns left or right in the table, drag-and-drop the column-head cell to the 
preferred position in the column head row. 

•	 To adjust the width of any column, use the sizing tool that becomes active when you 
hover your pointer over the right margin of the column-head cell. 

Note:	 The Insulin column contains the Insulin Type entered in the Prescribed Plan. See 
Section 6: Prescribed Plan for more information.
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Data Filter

For most column-heads in the table, you can configure a data filter using the selection list. To 
display the selection list for any column, click the down-arrow on the right.

•    To display data for all patients, with any or no entry in the corresponding data field, click 
All. 

•    To customize the data filter, click Customize. Complete the Filter Builder dialog box. 
•	 To save your custom changes:

1.	Click Customize (bottom right of screen). The Filter Builder screen displays.
2.	Click Save As. Enter a filename. Next, click Save.

Figure 102.  Filter Builder Tool
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6   Prescribed Plan
The FreeStyle CoPilot system provides an additional utility, called the Prescribed Plan.  This 
utility stores guidelines which have been given by your healthcare professional.

6.1      Prescribed Plan

You can use the Prescribed Plan to store and review prescribed guidelines from your HCP, for 
the following information:

•     Insulin type, dosage, and time of day 
•     Insulin sensitivity
•     Medication type, dosage, and time of day 
•     Carbohydrates for each individual meal time 
•     Ratio of amount of insulin per grams of carbohydrate 

You can add information for each of the items listed above, for breakfast, lunch, dinner, bedtime 
and a snack. You can also add comments or notes that you would like to keep.

Figure 103.  Prescribed Plan

Sensitivity

Sensitivity is your insulin sensitivity factor. It is based on the amount of blood glucose lowered 
by 1 unit of insulin within a specific time frame. This is also called your insulin correction 
factor. Your insulin sensitivity factor is determined by your HCP. 
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Ratio

Ratio is the insulin-to-carbohydrate ratio. It is used to determine how much insulin to 
administer per grams of carbohydrates eaten. Your insulin-to-carbohydrate ratio is determined 
by your HCP. 

WARNING: 
•	 Do not change your medication unless advised by your healthcare professional.

WARNING: 
•	 Be sure to enter and check all values carefully. The FreeStyle CoPilot system cannot check 

that the entries you make are correct for your personal needs. Serious effects on your 
health could result from relying on or using improper or incomplete entries. Discuss the 
data entry options available with your HCP so you are both clear on the amount and 
types of information for therapy analysis.

CAUTION:	 Contact your healthcare professional for guidance on determining and using 
your insulin dosages, insulin-to-carbohydrate ratios, and insulin sensitivities.

CAUTION:	 Contact your healthcare professional for guidance on determining and using 
your prescribed carbohydrate intake.

CAUTION:	 The FreeStyle CoPilot system does not calculate your insulin sensitivity or your 
insulin-to-carbohydrate ratio. These should always be determined by your 
healthcare professional.

6.2      Filling-in a Prescribed Plan

To fill in a Prescribed Plan:

1.	 Click References > Prescribed Plan on the menu bar. The Prescribed Plan  
screen displays.

2.	 Select an entry type from the Type list: Insulin or Medication.
•     Select Insulin to record an insulin type.
•     Select Medication to record a medication type. 

3.	 Enter the name of the Insulin or the Medication in the Item field.
4.	 Enter the Dosage Amount for each of the breakfast through snack meals. 
5.	 Select Ratio to record the optimum meal-based insulin-to-carbohydrate ratio. 
6.	 Select Sensitivity and enter the insulin correction factor your HCP calculated for you. 
7.	  Select Grams of Carbs to record the optimum carbohydrate intake. Enter the desired 

number of grams of carbohydrate for each meal field.
8.	  Enter any comments in the Comments field (optional).
9.	  Click OK to save and close the Prescribed Plan window. (Or, to clear all data entered into the 

plan, click Reset.)
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7   Sharing Data with the FreeStyle 
CoPilot Host

The FreeStyle CoPilot Host system resides on an Internet server managed by Abbott Diabetes 
Care. It allows home users and HCPs to securely share and exchange updated profile 
information, data uploaded from devices, and manually recorded health information:

•     Home users can exchange information with one or more HCPs. 
•     HCPs can exchange information with patients, and other HCPs. 

The FreeStyle CoPilot Host acts as a trusted intermediary. It uses a highly secure method of 
sharing data - the same type of security technology typically used for online banking and 
shopping.

the FreeStyle CoPilot Host allows home users to assign user rights to HCPs to allow or prohibit 
sharing of information, and read-only or read/write access.

To use the FreeStyle CoPilot Host, you must:

•     Install the FreeStyle CoPilot Health Management System (see Section 2: FreeStyle CoPilot  
System Installation.) 

•     Set up a Host account. 

7.1      Home Users - Sharing Information with Your HCP

the FreeStyle CoPilot system allows you to use the Internet to share your glucose test results 
and other recorded health information with one or more of your HCPs. 

•     To enable sharing, you send an invitation to your HCP using the FreeStyle CoPilot Host. 
•     You can choose to allow your HCP to either just view your profile and health information, 

or you can allow your HCP to add notes or entries, adjust your targets, or make other 
changes in your data or settings.

•     After your HCP accepts your invitation, you can easily update all of your collected data 
and recorded health information with the FreeStyle CoPilot Host, at any time.

•     Your HCP will use the FreeStyle CoPilot Host to retrieve your newest information for 
review.

•     If your HCP changes data or information, it is sent to the Host. The next time that you 
synchronize, you retrieve the information to review in the FreeStyle CoPilot system.

If you need help, you can ask your HCP to help you manage your settings (such as glucose 
targets), or to assist you in the interpretation of graphs, charts and reports.

7.2      HCPs - Sharing Information with Patients and Other HCPs

The FreeStyle CoPilot system Host allows you to exchange the FreeStyle CoPilot system data 
with your patients, or with other HCPs who want to share a patients information with you. With 
the FreeStyle CoPilot system Host, you can quickly and conveniently receive data - allowing you 
to review, analyze and interpret updated charts, graphs and reports.
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Your patients must first invite you - via the FreeStyle CoPilot system Host - to exchange 
information. They will grant you either read-only, or read/write access. With the latter, you can 
add notes or entries, adjust glucose targets or make other changes to settings. You can add 
important health information such as lab results, insulin and medications.

After you set up the FreeStyle CoPilot system Host account, the exchange of information occurs 
every time that you, or your patient, synchronize. 

•     When your patients synchronize, their information is sent to the FreeStyle CoPilot system 
Host.

•     When you synchronize, all new patient data is downloaded to the FreeStyle CoPilot 
system, allowing you to view patient profile and health information at any time 
convenient for you. 

•     If you make changes to a patient profile or add health information, it is saved in the 
FreeStyle CoPilot system. When you synchronize, new data is sent to the FreeStyle 
CoPilot system Host. 

•     Finally, when patients synchronize again, they receive updates (if any) that you made to 
their profile, data entries, recorded health information, and settings.

As an HCP, you can also invite other HCPs to view patient data.

7.3      Synchronization

Synchronization matches and updates the data between the FreeStyle CoPilot system installed 
on your computer and the Host System. Following synchronization, all new and modified data 
is reflected in both your local FreeStyle CoPilot system database and the database on the Host 
server. 

IMPORTANT:	 The Host processes synchronization requests in the order received. Therefore, if 
you and the party you share data with both edit the same piece of data, the 
party that synchronizes last will make the lasting change to the record in the 
database.

Note:	 If you select an item from the Host menu, the FreeStyle CoPilot system will try to 
connect to the Internet. If your Internet connection does not open automatically, please 
connect to the Internet before selecting items on the Host menu.

7.3.1   Host Account Setup

A Host account defines access, privileges, and functions associated with a particular user.

The first time a user synchronizes with the Host, the Synchronize window opens. Follow the 
steps on the screen and a Host account will be created for you and a confirmation e‑mail will be 
sent to you. You can verify your Host account number by looking on your User Profile screen. 
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1.	 Click the Synchronize icon , or click Host on the menu bar and select Synchronize 
(Home version) or Synchronize Current HCP (HCP version).

Figure 104.  Host Menu - Home User (left), HCP (right)

2.	 The End-User Agreement Screen displays. Review the End-User Agreement. Click Next to 
continue. 

Figure 105.  Host Account Number 

3.	 Proceed through the setup process on the screen. A password is established and a Host 
account number is assigned to the user (which now appears on your user Profile screen).

Figure 106.  Synchronization Summary
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4.	 The FreeStyle CoPilot system synchronizes the user’s account, and a summary of the 
synchronized data displays.

5.	 A confirmation message is sent to you from the Host and to your e-mail address. You will 
see the message in the message area in your FreeStyle CoPilot system Home page.

7.3.2   Synchronizing with the Host

If you have previously logged in and set up an account, synchronize with the Host as follows:

IMPORTANT:	 You should synchronize often with the Host. The Host regularly sends 
messages to you about new FreeStyle CoPilot system features even if you have 
not added or changed any information since the last time you synchronized.

IMPORTANT:	 Please verify that data was uploaded correctly before synchronizing with the 
FreeStyle CoPilot Host.

Note:	 Synchronization does not occur with the Guest profile that is used with Quick Print (see 
Section 4.1.5: Quick Print).

HCPs Only:  If data was uploaded from a device into an incorrect patient profile, please see 
Section 4.1.4: Data Transfer between Patient Profiles.

1.	 Click  (or click Host on the menu bar and select Synchronize (Home version) or 
Synchronize Current HCP (HCP version).

2.	 The FreeStyle CoPilot system synchronizes the user’s local and Host accounts.
3.	 A summary of the synchronized data displays.

7.3.3   Synchronize All Home Users

In a home, there may be more than one person using the FreeStyle CoPilot system. For 
convenience, a home user may synchronize the data for all home users using the FreeStyle 
CoPilot system Host with a click of the mouse.

1.	 Click Host on the menu bar and select Synchronize All. 
2.	 The FreeStyle CoPilot system displays a list of all the home users with the FreeStyle CoPilot 

system Host accounts. Synchronization starts automatically. A blue progress bar indicates 
when synchronization is complete for each home user’s data. Click Close.

7.3.4   Synchronize All HCP Users

In a clinic, for example, there may be several HCPs using the same the FreeStyle CoPilot system. 
For convenience, an HCP may synchronize the patient data for all HCPs using the FreeStyle 
CoPilot system with a click of the mouse.

1.	 Click Host on the menu bar and select Synchronize All HCPs. 
2.	 The FreeStyle CoPilot system displays a list of HCPs and Patients with the FreeStyle CoPilot 

system Host accounts. Synchronization starts automatically. A blue progress bar indicates 
when synchronization is complete for each HCP’s and patient’s data. Click Close.
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7.4      Invitation to Share Data

Once the user (Home or HCP) sets up a Host account, they can authorize one or more HCPs to 
have access to the data. To do this, the user must initiate an “invitation” to the HCP to share data 
via the Host. This notifies the Host that the user will allow the selected HCP to view (and in some 
cases, edit) their data. 

There are several ways to invite an HCP to share data: 

•     HCP has a Host account: Once you are logged into the Host, you can search for the HCP 
using the HCP’s State or Host account number. 

•     HCP does not have a Host account: You must know the HCP’s e-mail address.

Note:	 If the HCP fails to accept or decline the invitation within 30 days, the invitation to share 
data expires. You can send another invitation to the same HCP after 30 days.

7.4.1   Invitation to Share Data: HCP Has a Host Account

1.	 From the Host menu on the menu bar, select Invite to Share Data. 

Figure 107.  Invite to Share Data - Home User (left), HCP (right)

2.	 An Internet connection to the Host server will be opened and the following screen will 
display:

Figure 108.  Invite HCP to Share Data 
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3.	 Select the appropriate option, A.) or B.):
A.) If you don’t know the HCP’s Host account number:

•	 Select: Search Host HCP database to find an HCP from the list of existing 
accounts. 

•	 Click Next. On the next screen, select the State where the HCP is located. 

Figure 109.  Find HCP from Existing Accounts 

•	 Click Search. HCPs from the selected state with a Host account will be displayed. 
Highlight the HCP you want and click Next. 

•	 The screen for selecting Access Level displays. 
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Figure 110.  Assign Access Level 

•	 Select Read-Only Access or Full Access (Read and Enter Data), and click Submit.
•	 The Host displays the Process Complete screen and sends an invitation to share data 

to the HCP.
B.)  If you know the HCP’s Host account Number:

•	 Select: Enter the Host HCP Account Number given to you by your HCP. 

Figure 111.  Invite HCP to Share Data 

•	 Click Next. On the next screen, enter the Host HCP Account Number. 
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Figure 112.  Enter Host HCP Account Number 

•	 Click Search. The HCP is displayed as the search result. If this is the HCP you are looking 
for, click Next. 

•	 The screen for selecting Access Level displays. Select Read-Only Access or Full 
Access (Read and Enter Data), and click Submit. 

Figure 113.  Assign Access Level 

•	 The Host displays the Process Complete screen and sends an invitation to share data 
to the HCP.
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7.4.2   Accepting an Invitation from the Host to Share Data (HCP)

If a home user issues an invitation to share their data with you, you will see a message in the 
Messages From FreeStyle CoPilot Host window.

Note:	 If you fail to accept or decline the invitation within 30 days, the invitation to share data 
expires. 

1.	 Double-click the message header to display the invitation to share data.
2.	 To accept the invitation, click Accept Invitation. The Host synchronizes with your  

system, and the patient’s data is uploaded to your computer. A summary of the 
synchronized data displays:

3.	 Click Close to exit. You have successfully accepted the invitation and received the patient’s 
data. 

7.4.3   Invitation to Share Data: HCP Does Not Have a Host Account

If the HCP does not have a Host account, you can send an e-mail invitation to the HCP to share 
data. You must know the HCP’s email address.

1.	 From the Host menu on the menu bar, select Invite to Share Data. An Internet connection 
to the Host server will open and the following screen will display:

Figure 114.  Invite HCP to Share Data 
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2.	 Select: Send an e-mail invitation to an HCP who does not have an existing account.
3.	 Click Next. When the next screen opens, enter the Name and E-mail Address of the HCP 

you wish to invite. Click Next. 

Figure 115.  E-mail Invitation to HCP with No Host Account

4.	 The screen for selecting Access Level displays. Select Read-Only Access or Full Access 
(Read and Enter Data), and click Submit.

Figure 116.  Assign Access Level

5.	 Click Next. The Host displays the Process Complete screen.
6.	 The Host will send the HCP an e-mail inviting him/her to have access to your data. The 

message instructs the HCP to:
•     Download the FreeStyle CoPilot Health Management System.
•     Install the software and set up a user profile. 
•     Synchronize with the Host and set up a Host account. 
•     Make note of the Invitation Code included near the end of the e-mail.

7.	 The Host will notify you when the HCP has accepted the invitation to share data. If you 
don’t receive this message within a reasonable period of time, contact the HCP directly. 

Note:	 Be sure to synchronize regularly with the Host to receive current messages.
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7.4.4   Accepting an E-mail Invitation to Share Data (HCPs Only)

Note:	 If you fail to accept or decline the invitation within 30 days, the invitation to share data 
expires. 

When you receive an e-mail invitation to share data, the message will instruct you to:

•     Download the FreeStyle CoPilot Health Management System from the Internet.
•     Install the software and set up a user profile. 
•     Synchronize with the Host and set up a Host account.
•     Make note of the Invitation Code included near the end of the e-mail.

After you have downloaded and installed the software, set up your user profile and register 
with the Host:

1.	 Click Host > Accept E-Mail Invitation. 

Figure 117.  HCP: Host Menu

2.	 The FreeStyle CoPilot system connects to the Host server and the following screen displays:

Figure 118.  Accept Invitation 
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3.	 Enter the Invitation Code in the box provided and click Next. The Host synchronizes with 
your system, and the patient’s data is downloaded to your computer. A summary of the 
synchronized data displays.

Figure 119.  Synchronization Screen

4.	 Click Close to exit. You have successfully accepted the invitation and received the patient’s 
data. 
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7.5      Managing Shared Data: Home User

•	 Using the Add User From Host function, you can automatically set up a Host account on 
your PC if your HCP has already set up a profile for you on the HCP’s local PC and 
synchronized with the Host. 

•	 Using the Manage Shared Data function, you can limit, expand, or deny an HCP access 
to your data on the Host . 

IMPORTANT:	 If you select an item from the Host menu, the FreeStyle CoPilot system will try 
to connect to the Internet. If your Internet connection does not open 
automatically, please connect to the Internet before selecting items on the 
Host menu.

7.5.1   Add User From Host

The option to Add User From Host is a convenient way to:

•	 Create an additional Host account for yourself on a second PC.
•	 Automatically re-set up your Host account after reinstalling the FreeStyle CoPilot system 

on the same PC.
•	 Automatically set up your Host account on your PC. (To do this, your HCP must first set up 

your profile on their PC, synchronize with the Host, and select Activate Local Patient. 
You will receive an email with your Host account number and password.)

To add a User from the Host:

1.	 Click  . The User List displays.

Figure 120.  User List

2.	 Click Add User From Host from the File menu on the User List screen.

Figure 121.  User List: File Menu
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3.	 The Add User From Host screen displays. Fill in your Host Account and Password and follow 
the on-screen prompts. (Your account number and password is sent to you in an email after 
your HCP follows steps to set up your profile, synchronize, and activate you.)

Figure 122.  Add User From Host 

4.	 Click Next. Your profile and data are downloaded from the Host.
5.	 Your User List now includes your account profile and account number. 

Figure 123.  User List: Account and Account Number

IMPORTANT:	 If this activity creates a second account for you, you should delete the Local 
Account not yet synchronized with the Host. However, to retain any manually entered data, 
you should export it from the Local Account before deleting it. You should import the data 
into your new account (see Section 4.5: Exporting Data and Section 4.4: Importing Data from 
the Database Files). After deleting the Local Account, you should again read your meter and 
assign it to the new account.
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7.5.2   Manage My Shared Data: Defining HCP Access

1.	 Click Host > Manage my shared data.

Figure 124.  Home User: Host Menu

2.	 The next screen shows a list of each authorized HCP along with the level of access you 
granted to them. 

Figure 125.  Manage My Shared Data 

3.	 Highlight the HCP whose access you wish to change and select one of the following:
•    Grant NO Access: Removes all access to your data by the listed HCP.
•    Grant Read-Only Access: Restricts the HCP to viewing your data.
•	 Grant Full Access: Allows the HCP to view and edit your data, including event data, 

glucose targets, your prescribed plan, etc.
4.	 Click Close to exit. The Host sends a message to the HCP about the changed access level.
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7.6      Managing Shared Data: HCP User

You can unsubscribe a home user, which means you will no longer have access to their data. Or 
you can activate a home user whose data you manage, which will convert the home user to an 
individual user with access to the FreeStyle CoPilot system and their data on the Host. 

7.6.1   Unsubscribing a Patient

1.	 Click Host > Manage data being shared with me.

Figure 126.  HCP User: Host Menu

2.	 The next screen shows a list of the patients who share data with you. 

	

Figure 127.  Manage Data Being Shared with Me 

3.	 Highlight the patient that you want to unsubscribe. Click the Unsubscribe button.
4.	 Your Access Level for this patient is now NONE. The Host will send you a message 

confirming your changed Access Level. The next time the patient or the HCP who assigned 
the patient to you synchronize with Host, your Access Level on their Manage My Shared 
Data screen will be NONE. 
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7.6.2   Activating a Local Patient

1.	 On the Home page, select your name from the Select HCP list.

2.	 Next, click . The Patient List will display. Highlight the name of the patient that you 
want to convert to an individual user. You will still be able to share data with this patient 
after converting him/her to an individual user. 

Figure 128.  Patient List with Name Highlighted

3.	 Click Activate Local Patient from the File menu on the Patient List screen.

Figure 129.  Activate Local Patient

4.	 The Activate Local Patient screen displays. Enter the e-mail address of the patient you wish 
to convert to an individual user. 

Figure 130.  Activate Local Patient 

5.	 Click Next. The Process Complete! screen appears, telling you that the patient  
has been converted to an individual User. 

6.	 The FreeStyle CoPilot system sends an e-mail to the patient telling them about their new 
status as an individual user.
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8   Database Management 

The FreeStyle CoPilot system can create and alternately use more than one database. When you 
start the FreeStyle CoPilot system, it uses the same database that was used when the 
application was closed the last time. The FreeStyle CoPilot system changes databases only 
when you select a different database. 

To ensure that your information remains accurate, the FreeStyle CoPilot system allows you to 
perform database maintenance. You can use the Database Maintenance feature to:

•     Archive: Remove old data from the database and save it in a file.
•     Backup: Save a copy of your current database in a backup file.
•     Restore: Restore data from the last database backup or other database file.

8.1      Archiving Data

When you archive data, the data being archived is removed from the FreeStyle CoPilot system 
database and stored in an XML file format. (To restore archived data, see Section 8.3: Restoring 
Archived Data.) 

To create an archive data file: 

1.	 Select File > Database Maintenance > Archive. 

Figure 131.  Database Archive Command

2.	 In the Archive Data window, select the last date of the data to be included in the archive 
and click OK. 
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Figure 132.  Select Archive Event Date 

3.	 When the file browser window opens, enter the filename to save the archived data and 
click Save.

4.	 A confirmation message is displayed when the process is complete.
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8.2      Viewing Archived Data

You can open and view archived data at any time.  The location of the archived data file (*.xml) 
depends on which operating system you are using.

For Windows XP, this location is in:

C:\Documents and Settings\All Users\Application Data\AbbottDiabetesCare\CoPilot\
Archives

For Windows Vista and Windows 7, this location is in:

C:\ProgramData\AbbottDiabetesCare\CoPilot\Archives

8.3      Restoring Archived Data

You can import archived data back into the FreeStyle CoPilot system database at any time. 

Note: It is a good idea to create a database backup before you import data. (See Section 8.4.2: 
Manual Database Backup.)

1.	 Select DataEntry > Import > Import Events from File.

Figure 133.  Restore Archive Data (Import Events from File)

2.	 When the file browser window opens, select the archived data file (*.xml) and click Open.
3.	 The archived data will begin importing and a status message will indicate the progress.
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8.4      Backing Up the Database

8.4.1   Automatic Database Backup

When the FreeStyle CoPilot system closes, it automatically creates a database backup file with 
the filename format of “AUTO_<database>.bak”, where <database> is the filename of the 
database that was just closed. To ensure that your data is safely stored, be sure to exit the 
FreeStyle CoPilot system when you are finished.

If you have a large database, an hourglass will appear until the automatic backup is complete. 

The location of the automatic database backup file (*.bak) depends on which operating system 
you are using.

For Windows XP, this location is in:

C:\Documents and Settings\All Users\Application Data\AbbottDiabetesCare\CoPilot\
Backups

For Windows Vista and Windows 7, this location is in:

C:\ProgramData\AbbottDiabetesCare\CoPilot\Backups

An automatic database backup file (*.bak) can be used to restore the last opened database file 
if the FreeStyle CoPilot system is unable to open the database when it starts.  This situation may 
occur if the FreeStyle CoPilot system is unable to locate the database file (*.cpd) due to 
corruption, manual deletion by a user, or other unexpected conditions.

If an error message appears indicating that the FreeStyle CoPilot system is unable to connect to 
the database when it starts and you want to restore the last opened database:

1.	 Click OK.  The next message will ask if you want to open another database, restore the 
database from the backup, or create a new database.

Figure 134. Error Opening Database Message.

2.	 Select Restore it from the backup, and click OK.
3.	 A confirmation message will appear indicating that the Restore will overwrite the current 

database with the backup copy.  Click Yes to complete the operation.
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8.4.2   Manual Database Backup

You can create a manual backup of your database at any time. A manual database backup 
(*.cpb) can be restored by selecting File > Database Maintenance > Restore. (See Section 8.5: 
Restoring a Database Backup.)

Note:  For added security, the manual database backup file may be copied onto an external 
media (such as a CD or DVD disk) or other storage location.

To create a manual database backup:
1.	 Select File > Database Maintenance > Backup.
2.	 When the file browser window opens, enter the filename to save the database backup file 

and click Save.

IMPORTANT:	 As a precaution, you should make a full backup of your FreeStyle CoPilot system 
database before upgrading your operating system.

8.5      Restoring a Database Backup

A manual database backup can be restored at any time.

8.5.1   Restoring a Database Backup File

To restore a manual database backup:

1.	 Select File > Database Maintenance > Restore.  A message will appear asking you to 
confirm the operation.

Figure 135.  Confirmation Message

2.	 Click Yes.
3.	 When the file browser window opens, select the database backup file (*.cpb) to restore and 

click Open.
4.	 The selected database is restored and a message will appear asking if you would like to 

view the restore log file. 

8.5.2   Viewing the Restore Log

You can open and view the Restore Log at any time. The location of the Restore Log file 
depends on which operating system you are using.

For Windows XP, this location is in:

C:\Documents and Settings\All Users\Application Data\AbbottDiabetesCare\CoPilot\Logs

For Windows Vista and Windows 7, this location is in:

C:\ProgramData\AbbottDiabetesCare\CoPilot\Logs
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9   Security
This section explains how to set up and use User IDs and Passwords. It also explains how to set 
User Rights, the feature that allows an HCP or home user to define access rights for their own 
profile, and/or for other profiles (users) that share the system. 

When you set user rights, you define the ability to create or edit other profiles, to synchronize 
data with the FreeStyle CoPilot Host, to define user rights for others, and to configure the 
FreeStyle CoPilot system settings.

9.1      System Administrator Profile

In the FreeStyle CoPilot system, there is a built-in user profile for the FreeStyle CoPilot System 
Administrator. You cannot use the system administrator profile to upload data or enter 
information. This profile is used generally for configuring security (user rights). It cannot be 
deleted, and system administrator user rights cannot be revoked. If you like, you can set or 
change the system administrator’s password using the procedure below.

The default password for the system administrator is Admin. Follow procedures below to 
enable password protection.

9.2      Password Protection

Each user has a user ID (the name used for the profile). Defining a user ID is a required step in 
creating a profile. You can set the FreeStyle CoPilot system to request a user ID and password 
each time the FreeStyle CoPilot system starts, or each time a different user is selected in the 
Select User list (home user version) or Select HCP list (HCP version). 

To turn on password protection: 

1.	    Click File > System Settings. 
2.	    In the System Setting window, select Require User Logon.

Note:	   If File > System Settings is gray, you do not have the user rights to turn on password 
protection. See Section 9.3: Defining User Rights.



Back to Table of Contents 	 131

 
Section 9: Security

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

IF YOU CAN READ THIS MAGENTA TEXT ABOVE AND BELOW, THEN THIS IS NOT THE FINAL CD-PRODUCTION .PDF FILE. 

9.2.1   The Logon to System Screen

To log on to the FreeStyle CoPilot system, enter your user ID and password. 

1.	 Type in your User ID and Password.
2.	 Click OK. The Home page appears. 

9.3      Defining User Rights

Any HCP or home user can define user rights for their own profile, or for other profiles. (But only 
if they already have been granted permission to change user rights.)

The system administrator (in either the HCP or home user version) has unlimited user rights. 
The system administrator can set or revoke the user rights for any other profile.

If user rights are granted to a user (profile) to allow editing of user rights for others, HCPs and 
home users can set user rights as follows:

•     HCPs can define user rights for their own profile, or for other HCP profiles.
•     Home users can define user rights for their own profile, or for other home user profiles.

Note:	 User rights cannot be defined for the Guest profile that is used with Quick Print (see 
Section 4.1.5: Quick Print).
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9.3.1   User Rights Options for HCP and Home Users

User Rights Option Description
Edit Data Select to allow the user to edit events and user profiles. 

Without this right, the user cannot change or hide 
events, nor delete or change another user’s profile. The 
user can, however, edit his/her own profile, add another 
user, or enter (add) data by manual entry, device 
upload, or import.

Synchronize Data 
with Host  
(Home User version 
only)

Select to enable the home user to select Synchronize 
and Synchronize All on the Host menu. If you do not 
have this right, these options are grayed out.

Synchronize 
Current HCP  
(HCP version only)

Select to enable the HCP user to Synchronize Current 
HCP on the Host menu. If you do not have this right, this 
option is grayed out.

Synchronize All 
HCPs  
(HCP version only)

Select to enable the HCP user to Synchronize All HCPs 
on the Host menu. If you do not have this right, this 
option is grayed out.

Assign User Rights Select to allow any user to change user rights of other 
users. Deselect to allow the user to view but not change 
user rights (for others or their own.)

Configure System 
Settings

Select to allow the user to change System Settings. If 
the user does not have this right, the System Settings 
option is grayed out.
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9.3.2   Assigning Your Own User Rights - HCP and Home User

If you are the initial HCP or home user, you are automatically granted full user rights. With this 
status, you can change your own user rights and assign rights for other profiles. 

To change user rights in your own profile:

1.	 Open your profile 
2.	 Click Rights in the lower left corner.

3.	 The User Rights screen displays.
4.	 Check the rights that you want to grant to yourself. Uncheck the rights that you want to 

revoke. 
5.	 Click OK. 

Note:	 If you cannot change your own user rights, select System Administrator in the Select 
User list or Select HCP list. The system administrator can change user rights for any 
profile.

Figure 136.  User Rights: Home User and HCP User
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9.3.3   Home User - Assigning User Rights to Other Home Users

If you have set up more than one home user profile, you can follow this procedure to set user 
rights for another profile.

1.	 Click UserProfile > User List or, from the Home page, click  to display the User List. 

2.	 Select a user in the list. 

3.	 Click  to open the User Rights screen.
4.	 Check the rights that you want to grant. Uncheck the rights that you want to revoke. 
5.	 Click OK.

Note:	   Edit Data  allows the user to edit data/events and delete user profiles. 

9.3.4   HCP - Assigning User Rights to Other HCPs

If you have set up more than one HCP profile, you can follow this procedure to set user rights for 
another profile.

1.	 Click UserProfile > HCP List 

2.	 Select a user in the list. 

3.	 Click  to open the User Rights screen.

4.	 Check the rights that you want to grant. Uncheck the rights that you want to revoke. 
5.	 Click OK.
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9.4      Defining Access Right for the FreeStyle CoPilot Host

The FreeStyle CoPilot Host System resides on an Internet server managed by Abbott Diabetes 
Care. The Host database stores data that has been synchronized with the FreeStyle CoPilot 
system data on your PC. 

If you choose, data stored on the Host can be shared with other users. If you are a home user, 
you can choose to share your data with your primary HCP or several HCPs. HCP Users can share 
data with other HCPs. In either case, the user “invites” the other party to share data.

9.4.1   Host Account

A Host Account is created the first time a user synchronizes with the Host. A Host Account 
number is assigned by the Host. The Host uses the password you established on the Initial User 
Setup screen as your Host password. 

Once the Host Account is created, the Host Account number is entered automatically as a 
read-only field in the user’s profile. In addition, the Host Account number and password are 
sent to the user in a message that appears in the Messages from the Host area of the Home 
page. An e-mail with the same information is also sent to the user’s e-mail address. The 
FreeStyle CoPilot system uses the Host Account number and password each time the user 
synchronizes with the Host. After creating a Host Account, the password cannot be changed 
unless the local system is able to connect with the Host.

9.4.2   Defining Access Levels for the FreeStyle CoPilot Host Synchronization

The access level for a local account can be assigned as Read Only, Full Access, or Owner by the 
owner of the account. The owner is the user who created the profile (account). 

For Host users, the access level is assigned during the Invite to Share Data process. These 
access levels can be changed using the Manage My Shared Data options under the Host 
menu. When the access level is changed by the account owner, the changes take effect at the 
next synchronization. A Host message is also sent to the sharing party informing them that 
their access level has been changed.

•     When a new account is added, the user who creates the profile is automatically the 
owner of that account. The owner has Full Access (see below). In the HCP version, an HCP 
who created (owns) a profile for a patient can also transfer ownership to another HCP. 
Only one HCP, however, can be the owner of a patient on the HCP’s local PC. If the patient 
sets up a Host Account, the HCP’s owner access level changes to Full Access the next 
time the HCP synchronizes.

•     In most cases, Full Access to a patient’s data means the HCP may edit Events data and 
update the patient’s profile. The HCP may also upload from a patient’s device and 
synchronize data with the Host. This is not true, however, if the HCP does not also have 
these User Rights on their local FreeStyle CoPilot system.

Full Access can be granted only by:
•     A patient who has a Host Account
•     The HCP who originally created a patient’s profile on the HCP’s PC system. 
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With Full Access, any changes the HCP makes to data are uploaded to the Host during 
synchronization. Likewise, any new data on the Host for that patient is downloaded to the 
HCP’s local FreeStyle CoPilot system database. 

Full Access does not allow the HCP to authorize others to view a patient’s data. Only the patient 
or the HCP owner (see above) of that patient’s data can authorize data sharing. Also, Full Access 
does not allow the HCP to authorize others to view the owner’s data. Only the owner can 
authorize that.

•     With Read-Only Access, an HCP may view a patient’s data but not change it in any way. 
When generating a report for the patient, the HCP can change the Report Settings. The 
HCP cannot, however, edit Event data or Hide events. When the HCP synchronizes with 
the Host, any new data on the Host for that patient is downloaded to the HCP’s local 
system. 

•     None (no access) terminates an HCP’s access to the patient’s data. The patient’s name is 
removed from the Patient List on the HCP’s local FreeStyle CoPilot system. When the HCP 
synchronizes with the Host, no further data for that patient is downloaded to the HCP’s 
local system.
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Appendix A:   Contact Customer Care 
If you have questions after reading this User’s Guide, or for technical assistance, please contact 
Abbott Diabetes Care, Customer Care.

By Phone

The toll-free Customer Care line in the United States is 1-888-522-5226 and is available 
Monday through Friday, 8AM to 8PM Eastern Standard Time. FreeStyle CoPilot system 
support specialists are available Monday through Friday from 9:00 a.m. to 5:00 p.m. coast to 
coast.

By Email

For assistance by e-mail, visit www.AbbottDiabetesCare.com and click Contact Us. 
Complete the required information and select the subject Data Management Software 
Question. The form allows you to provide details about the problem or question you have. 
Click Submit and your email will be sent. Abbott Diabetes Care strives to respond to e-mail 
submissions within 48 hours. 
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Appendix B:   Troubleshooting
Should you still have a problem after completing the suggested corrections listed in this section, 
please call the Abbott Diabetes Care Customer Care line in the United States at 1-888-522-5226. 
FreeStyle CoPilot system support specialists are available Monday through Friday from 9:00 a.m. 
to 5:00 p.m. coast to coast.

Device Connection Problems

Devices Troubleshooting
Abbott Diabetes Care 
Blood Glucose 
Monitoring Devices

•	 Check your connection at the meter and the computer.

•	 Reset the device by turning off and on.

•	 Disconnect and reconnect the cable.

•	 Check the device user instructions.

•	 Other programs may be attempting to use the COM port.  
In this case, close all programs but the FreeStyle CoPilot 
system and see if it corrects the problem. 

•	 Review the settings on a switchbox if you are using one.

•	 COM port may not have been released by another program  
(e.g., PDA programs). PDAs tend to cause problems by 
occupying COM ports. Consider dedicating a COM port to your 
PDA and dedicating a different COM port to data uploads from 
other devices.
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Data Import Problems

Not all database imports will populate all the available fields in the Diary List. Appendix C: 
Supported Devices and Databases lists all the events and data that the FreeStyle CoPilot system 
is able to import from these databases. No HCP Profile information is ever imported. Importing 
a file imports patient data only, one patient at a time.

Source Troubleshooting
CoZmanager Software •	 CoZmanager software must be Rev. D or higher.

•	 Cozmo pump software must be Rev. F or higher.

Precision Link System •	 Precision Link system Versions 2.4 and lower are not 
supported.

FreeStyle Connect 
System

•	 COM port may not be released by another program (e.g., PDA 
programs). PDAs tend to cause problems by occupying COM 
ports. Consider dedicating a COM port to your PDA and 
dedicating a different COM port to data uploads from other 
devices.

XML Files 
TAB Files 

•	 Imports from a file (*.tab or *.xml) must be specially 
formatted for the FreeStyle CoPilot system. For instructions 
on creating these files, go to www.AbbottDiabetesCare.
com and download the file “FreeStyle CoPilot System Import/
Export Guide”.
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Printing Problems

You should download the latest printer driver from the manufacturer of your printer. If you change the 
orientation of the page (portrait, landscape) or change page size, view the page using Print Preview 
before printing to check formatting.

Problem Troubleshooting
Unclear Printing 
(Grayscale)

•	 Reports are clearest when printed on a color printer. For 
grayscale or black-and-white printing, display the report with 
distinctive patterns in black and white rather than color. See 
Section 5.3.3: Display Features.

Blacked out Regions in the 
Printout 

Blank Regions in the 
Printout 

Information is Missing on 
the Printout 

Extraneous Lines in the 
Printout 

•	 Certain combinations of operating systems, printers, and 
printer drivers may result in printouts that contain blank 
regions, black regions, or missing information. An alternate 
printing method has been provided in the program: You can 
save any report as a .pdf file and open the file in Adobe  
Acrobat Reader and print it from that application. Go to  
www.Adobe.com for instructions on downloading this 
application.

Internet Connectivity

Problem Troubleshooting
Host Menu Item 
Selection: Cannot 
Connect to the Host 

•	 When you select an item from the Host menu, the FreeStyle 
CoPilot system tries to open an Internet connection 
automatically. If your Internet connection does not open 
automatically, open it manually before selecting items on the 
Host menu.
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PDF Attachments

Problem Troubleshooting
E-Mail Report to: PDF 
File Not Attached

•	 The E-Mail Report to option is designed to access your e-
mail account and open a new e-mail message screen. The 
report is attached to the message as a *.pdf file. If your e-mail 
account is not detected automatically, you will need to 
e‑mail the report manually. To do so: With the desired report 
open, select the Save as PDF file option from the File menu. 
Attach the *.pdf file to an e-mail manually.

Access Violation Errors

If you receive an access violation error message, you should close the program and reopen it, 
even if the program allows you to continue. If you do not close and reopen the program, you 
may get further access violation error messages.  
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Appendix C:   Supported Devices and 
Databases

The FreeStyle CoPilot Health Management System supports many types of blood glucose 
monitoring devices and databases. 

This appendix provides a list of supported devices and databases along with the types of  
data and information that can be uploaded to the FreeStyle CoPilot system.

In addition, different devices may require different steps to upload data:

•     �Some devices upload all collected data to the FreeStyle CoPilot system, using the 
DataEntry > Read Abbott BG Meter command.

•    �Some devices may prompt you (via the FreeStyle CoPilot system) to select the types of 
data that you want to upload from a list of options.

If your device is not listed below, please contact Abbott Diabetes Care, Customer Care to 
determine if your device is supported.

Supported Devices and Databases

Precision Xtra and Optium Meter Interface
Glucose Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Glucose value
• Device ID (serial number)
Ketone Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Ketone value
• Device ID (serial number)

FreeStyle Family of Meters Interface
Glucose Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Glucose value
• Device ID (serial number)
• Status flag
• Cal code

CoZmanager Interface
User Contact Information
• First name
• Last name
Glucose Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Glucose value
• Device ID (serial number)
Correction Bolus Event Data
• Date/time of event
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• Dosage
• Administration type (correction, meal, general)
Meal Bolus Event Data
• Date/time of event
• Dosage
• Administration type (meal, general)
Basal Rate Event Data
• Date/time of event
• Rate
• Administration type (programmed, temporary)
Temp Basal Rate Event Data
• Date/time of event
• Rate
• Administration type (programmed, temporary)
Carbohydrate Event Data
• Date/time of event
• Carbohydrates
Daily Basal Insulin Sum Data
• Date
• Basal insulin daily total
Daily Meal Bolus Sum Data
• Date
• Meal bolus insulin daily total
Daily Correction Bolus Sum Data
• Date
• Correction bolus insulin daily total

Precision Link v2.5 and Higher Interface
Glucose Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Glucose value
Ketone Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Ketone value
User Contact Information
• First name
• Last name
Glucose Targets
• High value
• Low value
Time Periods
• Time periods

FreeStyle Connect Interface
User Contact Info
• Patient last name
• Patient first name
Glucose Targets
• High value
• Low value
Time Periods
• Time Periods
Glucose Event Data
• Date/time of event
• Data source (to distinguish manual or device)
• Glucose value
• Device ID (serial number)
• Status flag
• Cal code
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Appendix D:   Warning, Caution, and 
Important Messages

For reference, Warning, Caution and Important messages included in this guide are listed 
below.

WARNING Messages

The following WARNING messages are included in this User’s Guide.

Section 4

•	 To avoid the possibility of electrical shock, never perform a blood glucose test while the 
meter is connected to the computer.

•	 Be sure to enter and check all values carefully. The FreeStyle CoPilot system cannot check 
that the entries you make are correct for your personal needs. Serious effects on your 
health could result from relying on or using improper or incomplete entries. Discuss the 
data entry options available with your HCP so you are both clear on the amount and 
types of information for therapy analysis.

•	 Imports from the CoZmanager System include data only from full days (24 hours), not 
partial days. This is so that CoZmanager can provide daily totals.

Section 5

•	 Have your healthcare professional review and confirm your entries before using this 
data. Serious effects on your health could result from relying on or using incorrect 
entries.

•	 	 Imports from the CoZmanager System (pump) include data only from full days (24 
hours), not partial days. This is so that CoZmanager can provide daily totals.

	 • 	 �Some Deltec Cozmo Insulin Pump events such as disconnect, reconnect and cancelled 
boluses are not included.

Section 6

•	 Do not change your medication unless advised by your healthcare professional. 
•	 Be sure to enter and check all values carefully. The FreeStyle CoPilot system cannot check 

that the entries you make are correct for your personal needs. Serious effects on your 
health could result from relying on or using improper or incomplete entries. Discuss the 
data entry options available with your HCP so you are both clear on the amount and 
types of information for therapy analysis.
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CAUTION Messages

The following CAUTION messages are included in this User’s Guide.

Section 4

•     The FreeStyle CoPilot system assumes a single glucose calibration type, either plasma or 
whole blood.

•     Ensure that the time and date are set correctly on your personal computer and other 
devices.

•     When uploading glucose data from a device, the FreeStyle CoPilot system does not 
differentiate between devices that are whole-blood or plasma calibrated. The FreeStyle 
CoPilot system merely uploads the data with no calculations made. Because there are 
slight differences between the two calibrations, you should not mix data from devices 
that use different calibration references. It is possible to enter duplicate data entries into 
the FreeStyle CoPilot Health Management System. The FreeStyle CoPilot system does not 
check the accuracy of the data the user provides. For example, a user of the Deltec 
Cozmo insulin pump might record the carbohydrates for a meal (for example, 25 g) and 
enter it into the Deltec Cozmo software. When the user uploads the data from the pump, 
a meal entry (25 g) will be created in your FreeStyle CoPilot system. If the user also 
manually enters a meal entry (25 g) for that same meal in the FreeStyle CoPilot system 
Software, two meal entries would result (at slightly different times), thereby accidentally 
recording a total of 50 g for the meal. The user must take reasonable precautions to 
prevent duplication errors. For example, choose one location for recording certain data 
types (i.e., on a single device or in a particular software program).

•    Do not upload data from any device that has recorded data for more than one person. 
The FreeStyle CoPilot system cannot identify if data on a device has ever been recorded 
for more than one person. All data stored on a device is uploaded to the database for the 
person associated with the device in the FreeStyle CoPilot system. 

•     It is possible to enter duplicate data entries into the FreeStyle CoPilot Health 
Management System. The FreeStyle CoPilot system does not check the accuracy of the 
data the user provides. For example, a user of the Deltec Cozmo insulin pump might 
record the carbohydrates for a meal (for example, 25 g) and enter it into the Deltec 
Cozmo software. When the user uploads the data from the pump, a meal entry (25 g) will 
be created in your FreeStyle CoPilot system. If the user also manually enters a meal entry 
(25 g) for that same meal in the FreeStyle CoPilot system Software, two meal entries 
would result (at slightly different times), thereby accidentally recording a total of 50 g for 
the meal. The user must take reasonable precautions to prevent duplication errors. For 
example, choose one location for recording certain data types (i.e., on a single device or 
in a particular software program).

•     Contact your healthcare professional for guidance on determining and using your insulin 
dosages, insulin-to-carbohydrate ratios, and insulin sensitivities.

•     Contact your healthcare professional for guidance on determining and using your 
prescribed carbohydrate intake.
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Section 5

•     For glucose and insulin entries, if the Time Period is changed manually, all reports will 
still be displayed as defined by the Time Period setting in the User Profile.

•     If any event data is Hidden, a comment will appear at the top of the report indicating the 
number of Hidden events. Hidden data will not be displayed or included in the 
calculations for this report.

•     �If the user reconfigures the Glucose Modal Day report by turning Display Time Periods 
OFF, the Glucose Modal Day report will go back to plotting the data point based on the 
user-configured time period and remove the Time Period labels across the top of the 
graph. This can result in a data point for any glucose reading, where a user manually 
assigned the time period, being displayed in a different location on the Glucose Modal 
Day graph. When the Display Time Periods is ON, the glucose reading that has a 
manually assigned time period will be displayed on the graph in the middle of the time 
period assigned.

•     �Total Insulin statistics based on data from the CoZmanager System (pump) may differ 
from the sum of the individual insulin fields that make up the total. This is because 
CoZmanager may record the amount of a cancelled bolus. The Total Insulin statistic on 
any the FreeStyle CoPilot system report displays only the insulin delivered, not the 
cancelled bolus.

•     �Total Insulin statistics may appear to vary from report to report. This is usually due to 
how the report defines a day.

Section 6 

•     �Contact your healthcare professional for guidance on determining and using your 
insulin dosages, insulin-to-carbohydrate ratios, and insulin sensitivities.

•     �Contact your healthcare professional for guidance on determining and using your 
prescribed carbohydrate intake.

•     �The FreeStyle CoPilot system does not calculate your insulin sensitivity or your insulin-to 
carbohydrate ratio. These should always be determined by your healthcare professional.
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IMPORTANT Messages

Section 4 

•     �To avoid losing data, upload data from your device often. Most devices hold only a 
limited number of historical records.

•     Always refer to the user’s guide that came with your device or pump for complete 
instructions on its use.

•     �Any data you previously uploaded from a device will not be overwritten when you 
upload again from that same device. Only the new data will be added to your file.

•     Medication Event refers to all medications you take except insulin.
•     �Be careful to type numbers only into the Result Value field. For example, if your A1C test 

result is 7.6%, type 7.6 in the Result Value field and type % in the Units field. If you type 
the units in the Result Value field, the entry for this lab test will not be displayed correctly 
in the reports you generate.

Section 5 

•     �Please customize your Time Periods before entering data into the FreeStyle CoPilot 
system. If the Display Time Periods setting is turned on for the Glucose Modal Day 
Report, changing the Time Periods after data has been entered will result in the data 
appearing based on the Time Periods. This may result in data not corresponding to the 
event times.

Section 7

•     �The Host processes synchronization requests in the order received. Therefore, if you and 
the party you share data with both edit the same piece of data, the party that 
synchronizes last will make the lasting change to the record in the database.

•     �You should synchronize often with the Host. The Host regularly sends messages to you 
about new FreeStyle CoPilot system features even if you have not added or changed any 
information since the last time you synchronized.

•     �Please verify that data was uploaded correctly before synchronizing with the FreeStyle 
CoPilot Host.

•     �If you select an item from the Host menu, the FreeStyle CoPilot system will try to connect 
to the Internet. If your Internet connection does not open automatically, please connect 
to the Internet before selecting items on the Host menu.

•     �If this activity creates a second account for you, you should delete the Local Account not 
yet synchronized with the Host. However, to retain any manually entered data, you 
should export it from the Local Account before deleting it. You should import the data 
into your new account (see Section 7: Sharing Data with the FreeStyle CoPilot Host). After 
deleting the Local Account, you should again read your meter and assign it to the new 
account.

Section 8

•     �As a precaution, you should make a full backup of your FreeStyle CoPilot system 
database before upgrading your operating system.
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Appendix E:   FreeStyle CoPilot System 
Network Installation

About the FreeStyle CoPilot System Network Installation

This appendix provides instructions for setting up a network installation for the FreeStyle 
CoPilot Health Management System. The instructions assume that the user is setting up the 
FreeStyle CoPilot system database on a central computer (server) that will provide data access 
for one or more FreeStyle CoPilot system installations (clients) residing on other machines in a 
common network. The user setting up the network installation must have a working 
knowledge of Windows and basic networking terminology. 

Installing the FreeStyle CoPilot System Server 

Note:	 If the FreeStyle CoPilot system client application was previously installed, it will need to 
be uninstalled prior to installing the server.

1.	 Place the FreeStyle CoPilot system installation CD into the CD/DVD drive of the server.  Or, 
download the FreeStyle CoPilot LAN Database Installer from the Abbott Diabetes Care 
website (www.AbbottDiabetesCare.com).

Note:	 With the CD, do not install the FreeStyle CoPilot Health Management System program, 
which starts automatically.  Instead, open the contents of the CD and locate the LAN 
Server folder.

Open the LAN Server folder.

2.	 Install the FreeStyle CoPilot server on the host server by running the  
CoPilotServerSetup.exe setup file from the CD. (Or, if you had downloaded the setup 
program from the website, run the CoPilotServerSetup_US_Web.exe setup file).

3.	 When the installation is complete, go to the Windows Control Panel and open the Firebird 
2.0 Server Manager applet. Make sure it is configured like this:

Figure 137.  Firebird 2.0 Server Manager

Note:	 Be sure to click the Start button to run the Firebird Server application.

Start button
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Installing the FreeStyle CoPilot System Client Application

1.	 Install the FreeStyle CoPilot system client application (CoPilot_Setup.exe) on a client 
computer with network connectivity to the host server.

2.	 Run the client application. Select System Settings from the File menu. 

Figure 138.  File Menu, System Settings Command

3.	 The System Settings screen displays.

Figure 139.  System Settings

4.	 Under Database Options, select Remote.

5.	 For the Server Name, enter the computer name of the server. This is the 
name that the computer is identified by on the local network.

6.	 For the Database Name, enter the complete path and filename of the server database (for 
example, C:\Program Files\CoPilotServer\Database\CoPilot.cpd). DO NOT use the full 
path specification that includes \ComputerName\C\...

7.	 Click TEST. If the connection is successful, a confirmation message displays.
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Restarting the Client

1.	� Restart the FreeStyle CoPilot system on the client. You may need to set up the user again (as 
either a Home User or a Health Care Professional) even if you did so in the past. This will 
establish the server database as either a Home or HCP system. All subsequent clients that 
attach to the server database will use the established Home or HCP selection.

2.	� The lower left corner of the client should indicate the name of the current database 
(CoPilot.cpd, unless you have created and named your own FreeStyle CoPilot system client 
database).
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